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Libero IDE:
A Complete FPGA Design Solution

Comprehensive Development 
Environment

Design, implementation, validation, debug
Supports full suite of Actel’s power efficient 
FPGAs

Best in Industry Tools 
Industry leading synthesis and simulation 
tools
High performance timing and power driven 
place & route
SmartTime timing and bottleneck analysis 
speeds timing closure
Accurate hierarchical power analysis with 
SmartPower

Relentless Pursuit of Ease of Design
Push button flows hide design complexity
GUI wizards guide design process
Rich IP library & user block support 
facilitates design reuse

3
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Libero IDE Gold Edition

 World Class Fully-Integrated PC Development System

Targets All Devices up to 1.5M Gates
Tools:

ViewDraw AE v8.5
WaveFormer Lite 12.30a
ModelSim AE 6.4a
Synplify AE  9.4A (1.5M gates)
Actel Designer 8.5(1.5M gates)
FlashPro 8.5
Silicon Explorer 5.2

PC Platform
Licensed to Disk ID (Node-Locked license)

1 Year Free License!
No Updates (Service Packs Available) WinXP Pro   

SP2 a
Win Vista 
Business a

Tool Features
Integrated Design Management a
Schematic a
VHDL  a

Verilog  a
Macro Generation a
Testbench Generator a
VHDL Simulation                              
Verilog Simulation a
Timing Simulation a
Static Timing Analysis a
Timing Driven Place and Route a
Push Button Place and Route a
Layout Editor a
Silicon Explorer a
Standard Industry Interfaces a

Third Party Design Libraries a



Actel Corporation Confidential © 2009 5

Libero IDE  Platinum Edition
Windows Support

Targets All Actel Devices
Tools

ViewDraw AE v8.5
WFL 12.30a with Reactive Testbench Generation
ModelSim AE 6.4a
Synplify Pro AE 9.4A (No Gate Limit)
Actel Designer 8.5 (No Gate Limit)
FlashPro 8.5
Silicon Explorer 5.2

License Types
Node-Locked License Tied to Disk-id or Hardware Keys
Floating License

Price:  
$2495 First Year / $1995 Renewal
Free 45 day Evaluation License

 World Class Fully Integrated PC Development System

WinXP Pro   
SP2 a
Win Vista 
Business a

Tool Features
Integrated Design Management a
Schematic a
VHDL  a

Verilog  a
Macro Generation a
Testbench Generator a
VHDL Simulation                              
Verilog Simulation a
Timing Simulation a
Static Timing Analysis a
Timing Driven Place and Route a
Push Button Place and Route a
Layout Editor a
Silicon Explorer a
Standard Industry Interfaces a

Third Party Design Libraries a
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Libero IDE
Solaris and Linux Support

Libero Solaris, Libero Linux
Tools

Project Manager
Synplify Pro AE
ModelSim AE VHDL & Verilog
Designer

Supports All Devices
License Type: Floating

Solaris: Host ID only
Linux: requires USB key for Synplify

1 Year License: $2495
Renewal: $1995

Free 45 day Evaluation License
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Libero IDE
Edition Summary
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Libero IDE v8.5
Device Support by Edition



Libero IDE Installation



Libero IDE Project Manager
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Libero IDE Design Explorer Window

Hierarchy Tab Displays Hierarchical Representation of 
Source Files and Components in Project

Libero Automatically Updates Design Hierarchy

Design
Explorer
Window

Display Modules 
or Components
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Libero IDE Design Explorer Window

Files Tab Displays All Files in Project Grouped by Type
Components and user created files are displayed separately
Sort components by name or by type 
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Libero IDE Catalog Window: IP Cores Tab

IP Based Design Flow
Access to a variety of IP Cores

Configure and Instantiate Directly 
from Libero

No need to launch separate tools
No need to re-enter common 
information
No need to import generated 
cores

Modify Generated Cores Directly 
from Libero

Change Configurations
Change Versions
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Libero IDE Catalog Window: HDL Templates Tab

VHDL and Verilog Templates
Facilitate the Writing of HDL 
Files by Inserting Predefined 
Language Constructs
Create User-defined Template 
Files
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Libero IDE Project Manager: HDL Editor

Language-Sensitive HDL Editor
Verilog 2001 or VHDL 93 

HDL pane
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Libero IDE Project Manager: Project Flow Window

Tools Can Be Launched from 
Project Flow Window or Menus
Step-by-Step Design flow 
Decreases Development Time
Project Flow Window Displays:

Tools
Files
Transitions
Current State
Tool Tips

Display Changes Dynamically 
Based on Target Family
Tabs Switch Between Flow 
Window and HDL Window

Current state of design
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Libero IDE Project Flow Window: File Status

Group of Files Can Be …
… Missing

If ANY Are Missing, Block Is Shadowed Out
… Available and Current

Green Check Mark Is Shown
… Available, but Not Current

If at Least One is Not Current, Warning Icon Is Displayed

Synthesis 
Complete

Source  Modified –
EDIF Netlist not 
current

Synthesis  
Incomplete
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Libero IDE Project Flow Window: Tool States

Disabled => Button Is Shadowed
White => Available, but Not Yet Used
Green => Completed Successfully
Red => Error in Running Tool
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Libero IDE Project Flow Window: Config Options

Project Flow Window Can be Configured for Designs that do not Require 
Synthesis

Un-check if synthesis is not 
required
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Libero IDE Project Flow Window
Synthesis Not Required

Synthesis 
button 
disabled
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Libero IDE Log Window Error Manager

Error Manager Consists of Tabs in Log Window:
All: Displays All Messages
Errors: Displays Error Messages
Warnings: Displays Warning Messages
Info: Displays Information Messages

Default Error Message Colors can be Changed

Libero error manager tabs

Right
Mouse
Click!

Click in window to 
clear or copy text

Log Window
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Libero IDE Information Window

Displays New Features in Libero and File Properties

Libero 8.5 
New Features

Properties for 
selected file



Creating a Libero Project
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Libero IDE New Project Wizard

Menu-Driven Wizard
Project > New Project

Status Guide Shows Current 
State

All Fields Must Be Filled in to 
Continue

HDL Type Must Be Consistent 
with License
Next Button Goes to Next 
Wizard Screen
Finish Button Finishes/Closes 
Wizard after Making Changes 
and Saves All Selections

Use Browse button to change 
project location
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Libero IDE New Project Wizard
Select Device

Select Family
After Family Is Selected, Devices 
from that Family Are Displayed
After Device Is Selected, 
Available Packages for Device 
Are Displayed
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Libero IDE New Project Wizard
Select Tools

Synthesis
Vendor (e.g. Synplify)

Version
Stimulus

WaveFormer Lite
Select Version

Simulation
ModelSim

Select Version
Support for Mentor Graphic’s 
Leonardo Spectrum and 
Precision

Standard Tools Direct from 
Mentor

No Actel OEM Versions
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Libero IDE New Project Wizard
Add Files

Add Existing Design Files to Project or Create a Link
Schematics, Symbols, HDL (VHDL or Verilog), Stimulus (VHDL or 
Verilog), SmartGen Macros or EDIF Netlists

Select file type

Browse to file location
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Libero IDE New Project Wizard
Finish

Project Information Listed in Dialog Box
Click “Finish” to Complete Project Creation or “Back” to Make 
Corrections or Additions

Project summary 
shown in window
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Libero project file

Actelprj is the Default 
folder for Libero projects

Organization of Libero IDE Project Files
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Libero IDE Project Menu Options

Create, open, 
close and save 
projects

“Save-As”: Save 
Project with 
Different Name 
and/or in 
Different Location

List of Recent 
Projects
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Libero IDE Project Menu 
Project Settings
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Libero IDE Project Settings

Device - Change FPGA die or 
Package

Family cannot be changed
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Libero IDE Project Settings

Device - Change FPGA die or 
Package

Family cannot be changed
Flow - Configure HDL Netlist
and DRC Options
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Libero IDE Project Settings

Device - Change FPGA die or 
Package

Family cannot be changed
Flow - Configure HDL Netlist
and DRC Options 
Simulation - Specify 
Simulation Options

Simulation run time, testbench
name location of do files, etc.
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Libero IDE Project Menu
Tool Profiles

Specify Tools to Use for Project
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OEM Tools Support
Tool Profiles

Create or Edit Tool Profile for Project
Project > Profile
Select Third-Party Tools & Versions

Synthesis
Vendor and Version

Support for Synplify, Leonardo 
Spectrum and Precision

Simulation
ModelSim

Select Version
Testbench Generation

WaveFormer Lite
Select Version

Name Profile and Save
Edit or Add Profiles As Needed
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Add / Edit Tool Profiles

Add/Edit Profile Requires
… Name of Profile
… Choosing Tool

From Drop-down Menu
Choose Version

… Choosing Tool Location
Browse for Location
Specify Location
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Libero IDE Project Settings 
Files Organization

Specify Package or Header file Compile Sequence and 
Stimulus Files and Designer Constraint Files  
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File Organization
Source Files for Synthesis

Project > File Organization > Source Files for Synthesis
Specify the Order of Synthesis Files in the Project Manager 

Uncheck to manually specify synthesis files

Manually specify compile order
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File Organization
Source Files for Simulation

Project > File Organization > Source Files for Simulation 
Specify the Order of Project Files for Simulation 

Uncheck to manually specify simulation files

Manually specify compile order
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Files Organization
Designer Constraint Files

Project > File Organization > Designer Constraint Files
Specify Designer Constraint Files

Timing Constraints (.sdc) or Physical Constraints (.pdc and .gcf)
Files may come from Synthesis tool or generated by the engineer

Constraint files 
in project

Constraint files 
sent to Designer

Specify file import
order
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File Organization
Stimulus

Specify Stimulus Files for Simulation
Libero Supports Hierarchical Testbenches

Select Multiple Files 
Libero Does Not Automatically Determine Compile Dependencies 
of Stimulus Files

Set compile dependencies 
when testbench contains 
multiple files
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Libero IDE Project Menu
Designer Views

Select Different Views from Menu or Toolbar
Check layout results for each Designer view
Select from the Current Designer view drop-down menu and run 
layout 
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Libero IDE Designer Views
Add, Remove and Edit

Add, Rename or Remove Views
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Libero IDE Project Menu
User Preferences
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Libero IDE User Preferences
Automatic Check for Updates

Enable or Disable Checking for Software and IP Updates 
When Libero is Launched
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Libero IDE 
Checking for Software Updates Manually 

Manually Check for Software Updates from Help Menu
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Libero IDE User Preferences
Text Editor

Text Editor Selection
Use Libero IDE Text Editor or External Text Editor

File > Preferences  Text Editor Tab

Enter location of 
external text editor 
if selected

Un-check to use 
external text editor
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Libero IDE 
File Menu Options

Create, open, 
save and close 
files
Import and 
export files
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Libero IDE File Menu
Importing Files

Existing Design Files Can Be Imported into Libero Project
Schematics, Symbols, HDL (VHDL or Verilog), Stimulus (VHDL or Verilog), 
SmartGen Cores, EDIF Netlists, SDC Files, Constraint Files, Tool Profiles

Schematics (*.[1-9]*)
Symbols (*[1-9]*)
Hdl Source Files (*.vhd, *.v, *.h)
Components (*.cxf)
SmartGen Cores (*.gen)
CoreConsole 1.0 to 1.2 Projects (*.ccp)
Stimulus Files (*.vhd, *.vhdl)
Edif Netlists (*.edn)
SDC file (*.sdc)
Physical Design Constraint (.pdc)
VCD Files (*.vcd)
SAIF Files (*.saif)
Simulation Files (.mem, .bfm, .do)
Tool Profiles (*.ini)
Templates (*.vhd, *.v)

Select file type from
pull-down menu
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Project Manager File Linking

Link External Files to 
Project

Package
Source HDL
Stimulus
Constraint

Linked File Shows as 
Blue Text With Icon
Right Click on Link to 
Remove or Change
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Project Manager File Linking

Libero Does Not Manage Source File State 
Linked to file is alterable by project user
This may/may not be acceptable by source file owner

Options:
Save the linked source with a new file name
Make the Linked to file “read only”
Bring (import) the file to the local disk
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Project Manager Catalog Options

Download new Cores to IP Catalog
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Libero IDE Design Hierarchy

Libero Displays Design Hierarchy on 
Hierarchy tab in Design Explorer
Missing Files Indicated with “?”
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Libero IDE File Menu
Exporting Files

Export Tool Profiles and TCL Scripts
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Libero IDE 
Edit Menu Options

Copy, Paste, Undo

Find and Replace
Add / Remove 
Comments
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Libero IDE Edit Menu
Find in Files

Edit => Find and Replace
Search for Files, Words, etc
Specify by File Types
Specify where to Search

Text editor, files in project, modules in project
Match Whole Word
Match Case
Regular Expression

Results Shown in “Search Results” Tab in Log Window
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Find in Files
Cross Probing

Selecting File Name Presented in Find in Files Log Window …
… Opens Selected File in Libero Text Editor
… Highlights Match
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Libero IDE Edit Menu
Comment

Comment Command Allows Users to Comment Sections of 
VHDL or Verilog HDL
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Libero IDE Edit Menu
Comment

Comment Command Allows Users to Comment Sections of 
VHDL or Verilog HDL
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Libero IDE Edit Menu
Comment

Comment Command Allows Users to Comment Sections of 
VHDL or Verilog HDL
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Libero IDE Edit Menu 
Uncomment

Uncomment Command Allows Users to Uncomment 
Sections of VHDL or Verilog HDL
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Libero IDE Edit Menu 
Uncomment

Uncomment Command Allows Users to Uncomment 
Sections of VHDL or Verilog HDL
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Libero IDE Project Manager 
View Options

Enable / Disable Windows and Docking Bars
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Libero View Options
Maximize Work Area

Closes all Other Toolbars to Maximize Working Area
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Libero View Options
Maximize Work Area (cont.)

Editor Maximized
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Libero View Options
Restore Work Area

Restore Toolbars by Selecting “Restore Work Area”
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Libero IDE Online Help

HTML-based Help System
Help Available for Error 
Messages, Specific Screens and 
Menus
Hyperlinks to Application Notes 
and Actel Web Pages
Help Menu Provides Direct 
Access to All Libero PDF 
Reference Manuals



Libero IDE Design Flows
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Libero IDE Design Flows

Structural Schematic Flow
Contains only Actel ViewDraw Library Components or Mix of Actel
ViewDraw Library Components and Structural HDL
Top Level Must Be Schematic!
Synthesis Optional before Layout

Mixed-Mode Flow
Schematic and RTL Blocks

May also Contain Structural HDL Blocks
Top Level Must Be Schematic!
Synthesis Required before Layout

HDL Flow
Mixed VHDL and Verilog Support in Libero 8.5

Requires Synplify Pro AE and ModelSim PE/SE
May Contain Structural Blocks



SmartGen Macro Builder
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SmartGen Macro Builder

Create Macro Functions from User’s Parameters
Multiplexors, counters, memory elements, counters, comparators 
and I/O macros
Supports generation and configuration of Fusion peripherals 

Macros are Optimized for Actel Architecture
High Speed 
Small Area

Rule-based Generation Guarantees Functional Accuracy
Outputs:

Structural VHDL or Verilog (all macros)
Behavioral VHDL and Verilog (most macros)
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Using SmartGen Macros

SmartGen Macros Can Be Used in …
… Structural Schematic flow
… Mixed-mode Flow
… HDL Flow
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Using SmartGen within Libero

Steps:
Launch SmartGen from Libero IDE Project Manager
Create HDL Structural Implementation

VHDL or Verilog
HDL Flow

Instantiate Macro in Top-level RTL
Structural Schematic and Mixed-mode Flows

Create ViewDraw Symbol from Libero
Instantiate Symbol in Schematic
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Launching SmartGen from Libero

SmartGen is Integrated into Libero IDE
No Separate SmartGen tool in Libero
SmartGen Catalog Embedded in Libero Catalog Windows
SmartGen Generated Components Managed by Libero Seamlessly



Actel Corporation Confidential © 2009 76

SmartGen
Counter Example

Choose Function to Open SmartGen Create Core Dialog 
box

Double
Click!
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SmartGen
Counter Example

Select type   
and variation
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SmartGen
Counter Example

Complete the rest 
of the description

Enter width

Click Generate
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SmartGen Component Generation

Files appear on 
Libero Files tab

Generate 
behavioral VHDL 
or Verilog

Core 
name
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SmartGen Family Specific Features:
Fusion / ProASIC3 / Axcelerator

BusLVDS Macro
Available for Fusion and ProASIC3

Visual Configurator for Two-Port and Dual Port RAMs
Available for Fusion / ProASIC3 and Axcelerator

Soft FIFO Controller 
Available for Fusion / ProASIC3 and Axcelerator
Create Controller with or without Memory

Dynamic Clock Conditioning Circuitry (CCC) Support 
Dynamically change the CCC configuration by entering the 
control data serially
ProASIC3 and Fusion
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SmartGen RAM Visual Configurator

Dual-Port RAM Configurator Two-Port RAM Configurator
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SmartGen ProASIC3 PLL Configurator
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SmartGen Fusion Peripheral Support 

SmartGen Includes “System Builders” For Actel Fusion 
Peripherals

Analog Peripherals
Flash Memory Blocks
FlashROM
Easy Customization via Visual Configurators
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SmartGen Fusion Analog System Builder

Fusion “Analog 
System Builder”
category 
selection and 
configuration 
Intuitive menu 
for peripheral 
selection and 
configuration Select:

Voltage Monitor
Current Monitor
Temp Monitor
Direct Digital Input
Gate Driver
Real Time Counter
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SmartGen Fusion Flash Memory System Builder

Select:
Analog System
Initialization
Data Storage
RAM Initialization
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Structural and Mixed-Mode Flow
Using RTL and SmartGen Macros

Create RTL from Libero HDL Editor or Import File
OR

Create HDL Structural Implementation using SmartGen
VHDL or Verilog

Create ViewDraw Symbol from Libero and Instantiate Symbol in 
Schematic

Symbol Appears on Files Tab

Right
Mouse
Click!

Symbol



Structural Schematic Designs
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Structural Schematic Design Flow

Programming

Place & Route

Post-P&R Simulation

Pre-Layout
Simulation

Design Capture

Generate 
Structural Netlist



ViewDraw Overview
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Click ViewDraw Button in Project Flow Window
Create Schematic
Save and Check

Opening ViewDraw

Enter schematic 
name

Select schematic
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ViewDraw GUI

Zoom
Functions

Push 
symbol 

or 
schematic

Net 
and Bus
Connection

Drawing
Tools

Save+Check

Insert
Component

Command 
Window
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Select cell library

Enter cell name

Drag and drop
into schematic

Adding Schematic Components

Add > Component from ViewDraw Menu
Add SmartGen Macros, Custom Macros or Actel Basic Cells

Select VCC or GND from ‘actelcells’
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Adding I/O Cells

Add I/O Cells to Top-level Design Schematic
Schematic-only Designs or Structural Schematic Designs
Macros Contained in “actelcells” Component Library

I/O Cells Must Have Dangling Hierarchical Connector 
Attached to Pad Side

Label Dangling Connector
I/O Macros Can Be Buried in Hierarchy

Add and label 
this net

Add and label 
this net

Add and label 
this net
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Drawing Wires and Busses
Adding a Net

To Add Net:
Choose Add > Net (or Add > Bus)

Alternate: Click Wire (    ) or Bus (    ) Icon on Toolbar
Specify Net Origination Point and Depress Left Mouse Button
Drag Mouse to Form Net (or Bus), specifying Points along Net 
by Clicking Right Mouse Button 
Click Right Mouse Button to Insert Vertex in Net
Release Left Mouse Button to Specify Ending Point for Net
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Use Hierarchical Connectors from ViewDraw Built-in Library 
for All Designs

Add just like Any Other Component
Same Connector for Wire or Bus 
Called ‘in’, ‘out’, or ‘bi’ in Built-in Library

Label Net or Bus Next to Connector

Hierarchical Connectors 

add label to net add label to bus add label to net
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ViewDraw Attributes

A Limited Number of Attributes Can Be Entered into 
Schematic and Passed to Designer
$Array Attribute

Creates Arrays of Cells in Schematic
Useful for I/O Buffers

Double-click Cell, Enter on Attribute Tab
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Completed Schematic

Input buffers Output bufferActel library components
Hierarchical
connectors

Hierarchical
connector
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Design Rule Checking

At Design Entry Completion , Save and Check Design
Click Save Check Icon 
Use Tools > Schematic Checker

Design Rule Checker

DRC Check Results
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Design Entry Completion

Files in Implementation are Displayed on Libero Hierarchy 
and Files Tabs

Schematic
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ViewDraw File Structure on HDD

Schematic Files Saved in “sch” Folder
Symbol Files Saved in “sym” Folder
Wire Files Saved in “wir” Folder
Files Visible on Libero File Manager Tab
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Libero Schematic Checker (Optional)

Schematic Connectivity Checker in Libero
Checks for Errors Not Included in ViewDraw Save + Check
Optional Step Available from File Manager Tab

Right
Mouse
Click!
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Opening Existing Schematics

Double
Click!



Mixed-Mode Designs
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Mixed-Mode Design Flow

Place & Route

Synthesis

Programming

Simulation Post-Synthesis Simulation

Post-P&R Simulation

Design Capture
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Mixed Mode Design Entry

Mixed Mode => RTL Blocks within Schematic
HDL Blocks Can Be Structural or Behavioral RTL

Libero IDE Supports Mixed VHDL and Verilog Source Files
Top Level Must Be Schematic

Procedure
Create HDL Blocks

RTL Blocks - Use HDL Editor or Import Existing Design Files
Structural Blocks - Use HDL Editor or SmartGen

Create ViewDraw Symbols for HDL Blocks
Done Automatically from Libero

Instantiate Blocks in Schematics and Make Interconnects
Use Hierarchical Connectors from ViewDraw “built-in” Library for HDL 
Ports in Schematic
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Structural and Mixed-Mode Flow
Using RTL and SmartGen Macros

Create RTL from Libero HDL Editor or Import File
OR

Create HDL Structural Implementation using SmartGen
VHDL or Verilog

Create ViewDraw Symbol from Libero and Instantiate Symbol in 
Schematic

Symbol Appears on Files Tab

Right
Mouse
Click!

Symbol
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Mixed Mode Schematic
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Synthesis

Optional for Pure Schematic or Structural Schematic Flows
All HDL Blocks Are Structural VHDL or Verilog (e.g., SmartGen
Blocks)

Required for Mixed-mode Designs
Designs Containing RTL  Blocks

Libero Launches Synplicity to Insert Pads and Optimize 
Design

Hierarchical Connectors Must Be Used
Structural Schematics with All Pads Instantiated Can Go Directly to 
Designer Tool



HDL Designs
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HDL Design Flow

Place & Route

Synthesis

Programming

Post-Synthesis Simulation

Post-P&R Simulation

Design Capture

Simulation
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Creating New HDL Macros

Click
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HDL Editor

Color coded key 
words
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Inserting HDL Templates

To Insert Template:
Place Insert Cursor Where you want it in the HDL Text Editor
Double Click Selected Template or ..
Right Click and Select  “Copy template to a file”

Right
Mouse
Click!
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HDL Templates in Text Editor

Template is Inserted into Text Editor Window
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Libero HDL Syntax Checker

HDL Syntax Checker Available from Hierarchy or Files Tab 
Checks for Syntax Errors in HDL Blocks
Errors Indicated in Libero Log Window
Optional Step

Right
Mouse
Click!
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Files Can Be Deleted from Project and from HDD
Files Deleted from HDD Cannot Be Recovered!

Deleting Files from Libero Project

Right
Mouse
Click!



SmartDesign
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What is SmartDesign?

Powerful Block-based Visual Design Creation Tool
Instantiate blocks from a variety of sources

DirectCore IP, SmartGen, User HDL, Companion Cores, Actel library cells, and the list goes 
on. 

Supported for all platforms
Simple and Intuitive Design Creation

Auto Connect
Fast manual connectivity between blocks
Hierarchical design support

DRC
Checks rules to guarantee correct by construction design

Connectivity errors
Configuration errors
Special silicon rules

SOC Features
Auto Connect 

clocks and resets for processors and peripherals
Other known DirectCore connections

Memory Map Configuration Dialog
Testbench and Bus Functional Model (BFM) script generation
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Click SmartDesign Button in Project Flow Window
Add and Stitch Blocks
Generate HDL

Opening SmartDesign

Enter name
Select SmartDesign
Component
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SmartDesign Canvas 
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SmartDesign Canvas Enhancements

SmartDesign Canvas 
Instance pins are displayed on canvas.
Connections are shown using nets 

Displaying of Nets is optional
Selective enabling / disabling of showing nets

Drag and Drop directly from the Catalog into the Canvas
All Design Operations Available in the Canvas

Connect / Disconnect
Promote To Top
Tie Low / Tie High / Tie Constant / Inversion
Float
Split ( if bus )
Group
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Design with any block types

One Tool to Connect Your Design
DirectCore IP
SmartGen Cores
User HDL
Actel Macros ( And, Or, I/Os, etc )
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Canvas Instance

Instance Name

Unconnected
Required input pins 

are shown red

Connected pins are 
shown green

Pin with a default 
tie off value are 
shown in  light 

green
Pin tied off to ‘1’

Inverted signal 

Group Pin can be 
expanded for using 

sub pins

Pin marked as 
unused 

Pin tied off to ‘0’

Bus tied to a 
constant value

Bus Interface Pin



Actel Corporation Confidential © 2009 124

Cores Catalog

Library of Proven 
Configurable Core 
Functions

Actel Macros

Quick-find

Intuitive Configuration 

Drag and drop to 
Canvas

IP Configurator
(DirectCore)

Standard Configurator
(SmartGen)
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Making Connections

Right-click on a pin for Available Operations
Select 2 or More Pins With the CTRL key, Right-click and 
Connect
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Modifying Memory Map

Easy and Intuitive Method to Connect Peripherals at 
Particular Addresses on the Bus
Interactive and Immediate Updating of Base Addresses
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Fast Design Search 

Design Level Search 
Find Pins, Instances, and Nets quickly and easily
Wild card query
Matching objects will be highlighted in the Canvas
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Multiple Representations of the Design

Connectivity Grid
Spreadsheet like view of your design
Enables quick filtering / sorting

Schematic
Shows all pins and nets
Traditional schematic view
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Design Rule Checker 

Checks your Design for Errors
Invoke with Checker icon ( see picture )
Connectivity

Unconnected/Required input pins
Floating output pins
Silicon required connection

Example:  RTC must be driven by Crystal Oscillator 
Configuration

Check consistency between configurations
Example:  CoreMP7 and CoreMP7Bridge debug configuration

Errors Reported in a Connectivity Grid
Directly fix your connectivity mistakes
Enables fast sorting / filtering
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Testbench Generation

Design Testbench
Generates a top level testbench

Clock and Reset drivers automatically generated and connected

Bus Functional Model Script Generation
Generates BFM script file for processor based designs
Based on your peripheral connectivity in your designs
Look at Processor Core Handbooks ( ex:  CortexM1 ) for more 
details on BFMs and usage
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Datasheet Generation 

Design Datasheet
Pin outs of the design
Cores used and their description
Memory Map
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SmartGuide Design Guidance

Identify Silicon Design Rules and Compatibilities
Eliminate errors typically detected only at place & route time

Example: Using RTC in Fusion requires the Crystal Oscillator 

Detect and Flag Logic Design Errors
Eliminate errors typically detected only at synthesis time

Un-driven inputs
Floating outputs

Restrict Illegal Choices When Making Connections
Direction incompatibilities
Dimension mismatches 

Auto-connect Standard Interfaces
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SmartGuide Design Management

Streamline Iterative Design Changes
Unique to SmartDesign
Detect and flag out-of-date components
Assist in component interface updates

E.g. Removing connections to a deleted port

Synchronize Data Between Building Blocks
E.g., Flash Memory must be updated because Analog System 
changed

Flag the Next Steps For a Design Change
Example, Reprogram the Flash Memory region for Boot-Code if a 
new Boot-Code file is generated
Example, Re-synthesize the design if a new Analog peripheral is 
added to the design
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Hands-on Labs 1 and 2

Complete Labs 1 and 2 in the Lab Guide
Lab 1

Extract Lab Files
Create New Libero Project and Import Source Files

Lab 2
Configure FlashROM with SmartGen Save Your Work 
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Functional Simulation

Simulation Post-Synthesis Simulation

Post-P&R Simulation

Design Capture

Synthesis

Place & Route

Programming
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Simulation Flow

For Each Block You Want to Simulate . . .

Export Testbench

Generate stimulus   
WaveFormer Lite

Invoke simulator  

Associate Stimulus  

Compile and Run 
the simulation 

View Waveforms

Libero

ModelSim
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Invoking WaveFormer Lite

Double
Click!
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WaveFormer Lite Features

Allows Convenient Test Stimulus Specification via GUI
User Specifies Stimulus by Drawing Waveforms

Supports Copy / Paste / Append Operations
Significantly Reduces Testbench Creation Time 
Automatically Converts Graphical Stimulus Files into HDL 
TestBenches
Can Generate:

VHDL Testbench (*.vhd) 
Verilog Testbench (*.v)

Users Can Annotate Waveform For Design 
Documentation
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Signal level controls Zoom controls

Bus value controls

Drawing Stimulus

WaveFormer Lite Diagram Window

Inputs

Cursor
location
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Creating Clocks

Right
Mouse
Click!
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Creating Clocks

Click!
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Creating Clocks

Double
Click!
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Creating Clocks

Click!
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Creating Clocks

Clock 
frequency

Clock name

Clock 
duty     
cycle

Start high
or low
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Creating Clocks

Click!
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Creating Clocks

Click!
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Creating Clocks
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Drawing Signals

Select “low” state button



Actel Corporation Confidential © 2009 149

Drawing Signals

Toggle state
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Drawing Signals

State button toggles automatically

Align courser and click!
Use zoom controls to make viewing easier
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Drawing Signals

Align courser and click!
Use zoom controls to make viewing easier
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Drawing Signals
Edge Placement

Enter time for edge placement Double click at end of signal
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Editing Signals
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Editing Signals
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Editing Signals
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Editing Signals
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Editing Signals
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Drawing Busses

Double click “VAL” state button
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Drawing Busses

Button will stay in  “VAL” state
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Drawing Busses
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Drawing Busses
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Drawing Busses

Double
Click!
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Drawing Busses
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Drawing Busses

Click!



Actel Corporation Confidential © 2009 165

Drawing Busses
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Drawing Busses

Click!
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Drawing Busses
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Editing Signals
Appending and Inserting



Actel Corporation Confidential © 2009 169

Editing Signals
Appending and Inserting
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Editing Signals
Appending and Inserting
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Editing Signals
Appending and Inserting
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Editing Signals
Appending and Inserting
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Editing Signals
Appending and Inserting

Copy of waveform
is inserted!
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Fusion Analog Signals

WaveFormer Lite Supports Creation of Analog Stimulus for 
Fusion FPGAs
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Fusion Analog Signals

Specify Analog Signal Type

Select Temperature, 
Voltage or Current 
from list
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Fusion Analog Signals

Using Built-in Functions

,(Concatenate)
Inc(start, increment, count)
Dec(start, decrement, count)
IncString(“string”, start, increment, count)
Range(start, finish, count)
RandInt(count, Range_to_zero)
Hex(list)
Bin(list)
Rep((list, count)
Skip(count)
File(“filename.txt”)
Signal(“signalname”)
Map{operations} list
PRBS7(length, seed)
PRBS15(length, seed)
Sin(amplitudeV, period, duration)
SinStart(amplitudeV, period, duration)
SinEnd(amplitudeV, period, duration)
CapCharge(amplitudeV, RC, duration)
CapDischarge(amplitudeV, RC, duration)
Ramp(StartV, EndV, Duration)

Click to select list of signal functions
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Fusion Analog Signals

Analog Stimulus
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Saving Stimulus

Save Stimulus
File > Save

File Name May Contain Name of Top-level Module
Stimulus Appears on Libero File Manager Tab
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Generating the Testbench

Select Export from WaveFormer Lite Menu
WaveFormer Lite Has Many Export Options
Recommendations

VHDL Testbench - Select “VHDL with Top Level Testbench”
Verilog Testbench - Select “Verilog with Top Level Testbench”
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Waveform and Testbench

stimulus
testbench

Stimulus and testbench
appear on File Manager 
tab in Libero
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Design Verification 
with ModelSim AE
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ModelSim AE, PE, LE, & SE
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ModelSim AE

Same Functionality as ModelSim PE
Windows XP and Windows Vista Business

Node Locked

Reduced Performance
~ 30% of ModelSim PE Performance

Single Language
No co-simulation (VHDL and Verilog) capability

Structural Simulation Limited to Actel’s Gate-level Libraries
Pre-compiled libraries required

Supported Through the Actel
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ModelSim Default Window Layout

MDI
Pane

Dockable
Window

Workspace 
Tabbed 
Windows
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ModelSim Dockable Windows

Windows Within The Main Window Are Dockable
Move The “Drag Handle” To The Desired Location

Additional Window Features
Drag & Drop

HDL Items Can Be Dragged from Dataflow, List, Signals, Source, 
Structure, Variables, and Wave Windows …
… And Dropped into either List or Wave Window

Automatic Window Updating

Dockable
Window
Drag Handle

Zoom
Window Detach

Window

Close
Window
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Common Window Features

Drag & Drop
The HDL items can be dragged from the Dataflow, List, Signals, 
Source, Structure, Variables, and Wave windows and dropped into 
the List or Wave window

Automatic window updating
Dataflow, Process and Objects windows

Find Feature
Sorting HDL items

Sort ascending, descending or appearance order
Process, Signals, Source, Structure, Variables and Wave windows

Combining Items
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ModelSim Main Window

Main Window Appears when ModelSim is Launched

Transcript  - maintains a running history of 
commands that are invoked and messages 
that occur.

Workspace  provides access to 
projects, libraries, design 
files, compiled design units and 
simulation/dataset structures.
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ModelSim Main Window
Active Project with Design Loaded

Menu Bar

Status Bar (current time, 
delta time step, environment)

TCL Interpreter
ModelSim> prompt before design is loaded.
VSIM> prompt is displayed after design is loaded

Tool Bar (Break, Run, 
Cont, Step, and Step Over)

Design 
Hierarchy
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ModelSim Toolbar

SimulateCompile Compile
all

Simulation controlsZoom controlsCursor controls
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Workspace Window

Workspace Provides Access to:
Libraries
Compiled Design Units
Design Source Files
Memory Modules
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Source Window

View and Edit HDL source code
Color-coded comments, keywords, strings, numbers, executable 
lines, identifiers, system tasks, text
Save, compile and restart simulation from Source window

Features
Describe and Examine selected items
Find and Replace items
Set Breakpoints

•Blue line numbers – executable 
lines where a breakpoint can be 
set
•Red diamonds – enabled 
breakpoints
•Hollow diamonds – disabled 
breakpoints
•Blue arrow – denotes a process  
selected in the Process window
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Objects Window

Shows Names and Values of HDL Items in Current Region 
Selected in the Workspace

Objects include signals, nets, registers, constants and variables not 
declared in a process, generics and parameters

Items Can Be Sorted in Ascending, Descending or 
Declaration Order
Hierarchy (+) Expandable

VHDL Items - Signals
Verilog Items - Nets, Register Variables
Named Events

“Drag & Drop”
Wave & List windows

Force Apply Stimulus
Filter Signal Types (input,output
etc)
Find HDL Items
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Wave Window

Displays Waveforms of Simulation Results
VHDL – signals, processes and shared variables
Verilog – nets, registers, variables and named events
Virtuals – virtual signals, busses and functions

Path name Value Waveforms
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Wave Window Features

Drag and Drop from from the List, Process, Signals, Source, Structure, 
or Variables window
Timing Measurements with Multiple Cursors
Display Formatting

Dividers
Window Panes

Signal Formatting
Radix
Combining

Simulation Control
Breakpoints
Restart, Run
Run length

Sort
Ascending or descending

Zoom
Find

Zoom
control

Add / 
Delete
cursor

Find cursor
transition Simulation 

control
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Advancing Simulation Time
Main and Wave Windows

From Main Window
At the VSIM prompt:

VSIM 12> run 100 ms

In The Main Window Tool Bar:

From Wave Window
In The Wave Window Tool Bar:

Run Length       Continue Run     Break        Step 
Over

Restart                            Run      Run -all             Step  

Run      Run -all

Continue Run       Break

•Run - run the current simulation for the 
specified run length
•Continue Run - continue the current 
simulation run until the end of the 
specified run length or until it hits a 
breakpoint or specified break event
•Run –All - run the current simulation
forever, or until it hits a breakpoint or 
specified break event
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Restarting Simulation

Restart to Zero
At the VSIM prompt force a re-start
VSIM 12> restart –f

In The Main Window Run > Restart or Restart Button
Will display restart dialog.

Restart Dialog
Keep current

Listed Signals
Waved Signals
Breakpoints
Logged Signals
Virtual Signals
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Wave Window
Virtual Busses

Scalar Signals can be Combined into Vectors
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Wave Window
Virtual Busses

Scalar Signals can be Combined into Vectors
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Wave Window
Virtual Busses

Scalar Signals can be Combined into Vectors
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Wave Window
Virtual Busses

Scalar Signals can be Combined into Vectors
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Wave Window
Saving Wave Data

Signals Added to Wave Window can be Saved
File > Save from Wave window

Select Saved Wave Format in Libero Simulation Options for 
Future Simulation Runs
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Wave Window
Saving Wave Data (cont.)

Enter File Name in Save Format Dialog box
Enter name on Libero simulation tab to include signals in future 
simulation runs

Enter file name
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ModelSim Macro Files

ModelSim Commands can be Saved in a Macro File
The do command executes commands. 
A macro file can have any name and extension. 

Command line Syntax: 
do<filename> [<parameter_value>]
Example: do run.do

Macros can also be run from the Main Window Toolbar
Tools > Execute Macro

vlib presynth
vmap presynth ./presynth
vcom -93 -work presynth D:/Actelprj/count32/hdl/count32.vhd
vcom -93 -work presynth D:/Actelprj/count32/stimulus/count32.vhd
vsim presynth.testbench
add wave /testbench/*
run 1000ns
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Libero Simulation Options
ModelSim Do File Options

Simulation Options Can Be Set from Simulation Tab
Select Project > Options
Results Saved in run.do File

Specify simulation run time

Use Automatic Do File: Libero sets 
simulation options automatically

Generate VCD file
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Libero Simulation Options
User run.do File

Include user-defined script.  Browse 
to script file location
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Libero Simulation Options
Waveform Options

Specify Signals to be Displayed in ModelSim Wave Window

Log all signals during simulation
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Libero Simulation Options
ModelSim VSIM Commands

Specify Simulator Resolution and Post-Layout Simulation 
Operating Conditions

Default resolution based on family choice
1ps for 500K, APA, 54SXA, AX, ProASIC3/E, 
Fusion, IGLOO/e
1ns for all other families

Select min, typ, max 
simulation conditions for post-layout 
simulation
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Invoking ModelSim
Pre- or Post-Synthesis

Click “Simulation” Project Flow Window or …

Right
Mouse
Click

Click
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Associating Stimulus

Libero Prompts for Testbench if none is Associated
Select testbench from Organize Stimulus dialog



Actel Corporation Confidential © 2009 210

Associating Stimulus Manually

Select a Different Testbench for Simulation

Right
Mouse
Click!
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Pre-Synthesis Simulation

ModelSim Automatically 
Compiles Design and Runs 
Simulation

Default run time is 1 μS
(External) Signals from 
Testbench Automatically Added 
to Wave Window
Additional (Internal) Signals 
Can Be Added by User
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Simulating Designs
Summary

Capture Design
Generate RTL Netlist (VHDL or Verilog)

OR
Create Schematic

May Include RTL blocks
Structural VHDL or Verilog Netlist Automatically Created before 
Simulation

Create Testbench
Use WaveFormer Lite, or Text Editor

Associate Stimulus
Run Pre-Synthesis Simulation
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Hands-on Lab 3

Complete Lab 3 in the Lab Guide
Perform Pre-synthesis Design Simulation
Save Your Work 
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Synthesis

Simulation Post-Synthesis Simulation

Post-P&R Simulation

Design Capture

Place & Route

Programming

Synthesis



Actel Corporation Confidential © 2009 215

Invoking Synplicity

Click “Synthesis” in Project Flow Window or ..

Right
Mouse
Click!

Click
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Synplify Interface

Global synthesis
constraints

Change target 
and result file

Add constraint files or 
VHDL packages

Libero automatically lists files 
lowest levels first, top last



Actel Corporation Confidential © 2009 217

Synplify Pro Interface

Source Files

Global synthesis
constraints

Change target 
and result file



Actel Corporation Confidential © 2009 218

Result File 

Synplicity Produces an EDIF Netlist
<design>.edn

Libero Automatically Produces Structural VHDL or Verilog
Netlist

<design>.vhd or <design>.v
Results Appear on Files Tab under Synthesis Files
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Setting the Target Options

By default, Synplify will 
insert Actel I/O 
macros on all the HDL 
I/O ports.
When synthesizing 
lower-level blocks, this 
must be disabled.

High fanout = slow, small 
designs
Low fanout = fast, large 
designs
Use defaults for first 
pass
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Global Constraints

Frequency
Symbolic FSM Compiler
Configure HDL Compiler
Resource Sharing
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Global Frequency

Global clock frequency is applied to 
all clock domains in the design
Low value means optimize for area
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Symbolic FSM Compiler

When checked Synplify
identifies state 
machined in design and 
sets encoding 

Encoding method can be set on 
individual state machines with 
syn_encoding attribute in 
the HDL code
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State Machine Encoding (VHDL)

Options > Configure VHDL Compiler

Sets the default encoding style for enumerated types

Override encoding style on 
an individual basis using 
syn_encoding directive in 
constraint editor or the 
HDL source code

# of states default encoding
1 - 4 sequential
5 - 24 one-hot
> 24 gray
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Without resource sharing With resource sharing

Resource Sharing

When enabled, Synplify
performs automatic sharing of 
operator resources, including 
adders, subtractors, 
incrementers, and decrementers.

if (s = ‘0’) then
Y <= A + B;
else
Y <= C + D;
end if;

if (s = ‘0’) then
Y <= A + B;
else
Y <= C + D;
end if;

S

+
C

A

D

B
YY

S

B

A
+

D

C
+
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Performing Synthesis

Compile only or check syntax
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Synplify Log File

Synplify Log Contains 
Valuable Information:

Warnings and Errors
Double-click and Jump to 
Code!

Fanout Limit
Extraction Information 
(Found Counter, FSM, 
Adder, etc.)
Net Loading
Logic Buffering and 
Replication Information
Resource Usage
Critical Path Timing 
Analysis
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Reading the Log File
Errors

Double
Click!
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Reading the Log File
Errors
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Synplify Area Log File

Synplify Area Log Gives Hierarchical Breakdown of Area



Actel Corporation Confidential © 2009 230

Synplify Area Log File
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Synplify Constraint Editor (SCOPE)

Synplify and Synplify Pro 
Include a Spreadsheet-like 
Constraint Editor 
Extremely Easy to Use
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Synplify Constraint Editor (SCOPE)

Select File >New
Select Constraint File 
(Spreadsheet)
Select Files of type 

Constraint Files
Press OK



Actel Corporation Confidential © 2009 233

Constraint Editor (Cont.)

Constraint Editor tabs 
Support:

Clock Frequency or  Period

Constraint editor tab
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Constraint Editor (Cont.)

Constraint Editor tabs 
Support:

Clock Frequency or  Period
Clock to Clock timing
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Constraint Editor (Cont.)

Constraint Editor tabs 
Support:

Clock Frequency or  Period
Clock to Clock timing
Input/Output Constraints
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Constraint Editor (Cont.)

Constraint Editor tabs 
Support:

Clock Frequency or  Period
Clock to Clock timing
Input/Output Constraints
Register Constraints
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Constraint Editor (Cont.)

Constraint Editor tabs 
Support:

Clock Frequency or  Period
Clock to Clock timing
Input/Output Constraints
Register Constraints
Timing Exceptions
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Constraint Editor (Cont.)

Constraint Editor tabs 
Support:

Clock Frequency or  Period
Clock to Clock timing
Input/Output Constraints
Register Constraints
Timing Exceptions
Synthesis Attributes
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Constraint Editor
Drag and Drop Interface
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Constraint Editor
Drag and Drop Interface (Cont)
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Constraint Editor
Drag and Drop Interface (Cont)
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Constraint Editor
Drag and Drop Interface (Cont)

Select instance, port or net and drag 
into attributes tab



Synplify Directives and Attributes
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Synplicity Directives and Attributes

Let You Direct Analysis, Optimization, and Mapping of 
Design during Synthesis 
Attributes Control Mapping Optimizations

Attributes Can Be Entered in the Constraint Editor or HDL Source
Code

Synplify Supports Limited Number of Attributes that Can Be Entered in 
Attribute Pane of the SCOPE Editor
Most Attributes Are Entered in your VHDL or Verilog Code

Directives Control Compiler Optimizations 
Directives Must Be Entered in HDL Source Code
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NAME TYPE VALUE DESCRIPTION

syn_sharing D
1/0               
true / false

Enables / disables the resource sharing operators inside a 
module during synthesis

syn_black_box D
1/0               
true / false

Specifies that a module or component is a black box with only 
its interface defined for synthesis. The contents of a black box 
cannot be optimized during synthesis

syn_keep D
Prevents an internal signal from being removed during 
synthesis and optimization

alspreserve A Boolean Prevents a net from being removed during Place and Route

syn_encoding A

sequential, 
onehot, 
gray, safe Specifies encoding style for state machines

syn_maxfan A integer Controls the maximum fanout or an instance, net or port

syn_noclockbuf A
1/0               
true / false Disables automatic insertion of clock buffers

syn_radhardlevel A string
Specifies register design technique to apply to a module, 
architecture or instance

syn_replicate A 1/0 Disables register replication

syn_insert_buffer A
1/0               
true / false Directs Synplify to use specific I/O pads

syn_global_buffers A integer
Specifies the mumber of global buffers to be used in a 
ProASIC3/E, IGLOO/e or Fusion design

syn_ram_style A
Specifies the implementation to use for an
inferred RAM

Actel Attribute and Directive Summary
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Synplify and Synplify PRO for Actel

Synplify for Actel is Equivalent to Synplicity's Synplify
Product

Included in Libero Gold
Limited to Actel Products Only 

Synplify Pro AE has Additional Features
Included in Libero Platinum
Limited to Actel products Only
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Synplify Pro®

Synplify Pro Logic Synthesis

FSM Explorer 
Graphical State Machine 

Viewer
Pipelining of Multipliers and 

ROMs
Compile Point Creation 
Generic Cross-Probing of 

Critical Paths 
HDL Analyst®
STAMP Support 
Multiple Implementations & 

Workspace Support
Mixed Language design Entry  
Re-timing
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Language Sensitive Editor
Describe the design

functionality

Unique RTL View Technology View
View post-mapped schematic 

with annotated timing
Analyze a technology-

independent block diagram

Bi-directional cross-probing between all views

Synplify Pro
Powerful Graphical Debugging
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Synplicity Help

Synplicity Has Complete On-line Manual 
Invoked from Help Pulldown or by Pressing F1
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Opening Synplify Log Files
Libero Project Flow Window

Synplify Log Files can be Opened from Libero Project Flow 
Window

Right
Mouse
Click!
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Hands-on Lab 4 

Complete Lab 4 in the Lab Guide
Synthesize the Design with Synplicity
Save your Work
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Post-Synthesis Simulation

Simulation

Post-P&R Simulation

Design Capture

Place & Route

Programming

Post-Synthesis SimulationSynthesis
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Post-Synthesis Simulation

Steps:
Synthesize Design with Synplicity

Generate EDIF Netlist from Synplicity
Libero Automatically Creates Structural VHDL or Verilog Netlist

Run Post-synthesis Simulation on Structural Netlist

Right
Mouse
Click

Click
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Post-Synthesis Simulation

ModelSim Automatically 
Compiles Structural Netlist
Exported from Designer

Default simulation run time: 1 uS
Structural library mapping 
handled by Libero
Pre-compiled libraries do not 
require compiling prior to 
simulation
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Libero Overview
Libero Editions and Content
Libero Installation and Licensing
Libero Design Flows

3rd Party Tools
Designer Overview
Programming
Silicon Explorer
Reference Material

Agenda
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Place and Route

Post-Synthesis Simulation

Post-P&R Simulation

Design Capture

Synthesis

Programming

Place & Route

Simulation



Designer
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Open Design for Place & Route

Click on “Place & Route” in Project Flow Window or…

Right
Mouse
Click! Click
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Designer Constraint Files

Libero Automatically Prompts for Designer Constraint 
Files

Select Timing Constraints and Physical Constraints

Click
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Designer Interface

Designer Provides 
Graphical Flow Manager to 
Lead Designer through 
Design Flow
Completed Tasks 
Highlighted 
Design Flow Steps Listed at 
Top
User Tools Grouped Below

Designer Error Manager Tabs (same as Libero)
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Designer Interface (Legacy Products)

No MVN, SmartPower or 
SmartTime
Timer is used for Timing 
analysis
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Designer TCL Script Support

Industry-standard Language
Tool Command Language

Launch Multiple Tools from Single Script
Launch Multiple Design Runs

Simulator

Synthesis

DesignerTCL
script
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Running Scripts within Designer

In File Menu, Click Execute Script File
Displays Execute Script Dialog Box

Enter name of script file

Enter arguments to be passed
to  script file

Click Run to execute script

 Tcl Scripts can be Executed from the Command Line:
Example:

d:\Libero\Designer\bin\designer script:my_script
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Recording Scripts

Designer Can Export Tcl Script File that Contains 
Commands Executed in Current Session 
Exported Tcl Script can be used to …

… re-Execute Same Commands Interactively or in Batch
… Become More Familiar with Tcl Syntax
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Importing Source Files

Multiple files can be imported 
at the same time

Libero sends Netlist and 
Constraint files to Designer  
Automatically

Import File types:
File Type Extension
EDIF *.ed*
VHDL *.vhd
Verilog *.v
Actel ADL Netlist *.adl
Criticality *.crt
Timing Constraint 
File *.sdc
ProASIC Constraint 
File *.gcf
Physical Design 
Constraint File *.pdc
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File Type Extension
Criticality *.crt
PIN *.pin
Timing Constraint File *.sdc

ProASIC Constraint File *.gcf
Physical Design 
Constraint File *.pdc
Value Change Dump *.vcd
Switching Activity 
Intermediate File *.saif
Design Constraint File *.dcf

Importing Auxiliary Files

Optional step to import pin 
files, timing constraints, etc.

Import Auxiliary files after 
compile completes

Import File types:
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Entering Constraints in Designer

Option 1 - Import Files in Designer
Source Files are Passed by Libero Automatically

Option 2 - Import Files in TCL Script
Option 3 - Set All Constraints Directly in Designer

Physical – PinEdit or IO Attribute Editor
Timing – SmartTime or Timer
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Designer File Auditing

Designer Source File Auditing 
Ensures Imported Files Are Current

All Imported Source Files Are Date-
and Time-stamped 
Designer Notifies You if File Is 
Changed

Audit Settings Can Be Changed    
(File > Audit Settings)

Enable / Disable Auditing
Move File to New Location

Associate File with Current Date 
and Time
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Importing Files into Designer - Summary

Import the Following Source Files
EDIF, VHDL, Verilog Netlists
PDC, GCF and SDC Files
Source Files Are Audited per User Settings

Import the Following Auxiliary Files
DCF, SDC, PDC, GCF, VCD, and SAIF Files
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Designer Compile

Reads Netlist
Compiles Design into 
Actel Database (ADB) 
File
Runs Combiner
Performs Design Rule 
Checking
Checks for Netlist Errors 
(Bad Connections and 
Fanout Problems)
Removes Unused Logic 
(gobble)
Verifies that Design fits 
into Selected Device
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ProASIC3 Compile Options
Globals Management

Automatically Promote Nets to Globals
Automatically Demote Global Nets to Regular Routing 
Resources

Each option has an equivalent Tcl Compile command
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Constraint File Types by Family
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ProASIC3 Compile Options
Netlist Optimization

Perform Netlist Optimization
Use I/O Registers
Delete Buffers and Inverters
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Compile Wizard - Die and Package

Select:
Die
Package
Speed Grade
Die Voltage



Actel Corporation Confidential © 2009 275

Compile Wizard - I/O Attributes

Restrict Pin Usage
Reserve JTAG Pins
Reserve ActionProbe Pins

Select Default I/O Standard
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Compile Wizard - Operating Conditions

Select Junction Temperature
Commercial (0 - 70ºC)
Industrial (-40 - 85ºC)
Custom
Military (-55 - 125ºC)

Mil Devices only
Select Voltage Range

Commercial
Industrial
Custom
Military

Mil Devices only
Die and I/O Voltage Selections
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Operating Conditions
Radiation Derating

Radiation Derating for AX-S and SX-S
Add Radiation
Exposure Level for Radiation
Derated Timing



Designer Netlist Optimization
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Netlist Optimization
ProASIC3, Fusion, IGLOO and ProASICPLUS

Combiner can Remove all Buffers and Inverters from Netlist
that Have No Effect on Circuit’s Functional Behavior 

Reduces Overall Size of Design
Produces Faster Place and Route Times 
Takes Advantage of Inverted Inputs of Logic Tiles 

Original Netlist Preserved
Removed Cells Back-annotated with 0ns Delay in SmartTime
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ProASIC3, Fusion, IGLOO - Logic Combining

Combiner Can Combine VersaTiles Configured as 
Combinatorial Cells

Not Supported for ProASICPLUS

2 VersaTiles
combined into 
1 VersaTile

Fanout must be 1 to combine
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ProASIC3/E, Fusion, IGLOO/e
Netlist Optimization Constraint Options

Delete Buffer Tree
Instructs the Compile command to remove all buffers and inverters 
from a given net

Syntax:
delete_buffer_tree [netname]
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Designer Status Report
ProASIC3/E, Fusion, IGLOO/e Designs

Removed cells

Actual number of tiles used



MultiView Navigator
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MultiView Navigator

MultiView Navigator 
Includes the Following 
Tools:

PinEditor, I/O Attribute 
Editor, NetlistViewer, and 
ChipPlanner

Supported for the 
following families:

IGLOO/e, Fusion, 
ProASIC3/E, ProASIC3L

Supports Cross-probing 
Among Different Designer 
Tools

Click one of these buttons to open MVN
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MultiView Navigator

Design
Window

World View
Window

Log
Window

Working
Area

Toolbar IconsZoom Controls
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MultiView Navigator
Windows

Design Window
View Design as Logical Blocks, Physical Elements, Ports, Nets, and Regions

World View Window
Shows Position of Current Viewing Window Relative to Chip

Working Area Shows Current Active Tools
Tile or Cascade Active Tools

Log Window Keeps Running Log of Activity
Output – Shows All Messages
Errors – Shows Error Messages
Warnings – Shows Warning Messages
Info – Shows Informational Messages
Find Window – Keeps Result of Find Function for Later Usage
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MultiView Navigator Toolbar

File ->
Commit – Writes any Changes Made in Editors to Design
Prelayout Check – Verifies Placement Changes in Editors Are 
Legal

Edit ->
Undo/Redo – Allows User to Undo a Mistake or Redo an 
Accidental Undo
Find – Enables Find Interface

Zoom Controls
Zoom Region, Zoom In, Zoom Out, Zoom to Fit

Assignment Options
Place, Unplace, Lock (Fix), Unlock (Unfix)

Tools Menu
ChipPlanner, PinEditor, NetlistViewer, I/O Attribute Editor

“1 click" commands
Commit and Check
Lock All
Unlock All
Un-assign All from Location
Un-assign All from Region
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MultiView Navigator
Prelayout Checker

Infeasible Constraints Identified pre-Layout
Overlapping Region Checks
Resource Overbooking
I/O Technology Checks

Constraint Checker Runs Automatically when You Commit 
from MVN

Users Can Run DRC Checker from MVN Menu (Tools->DRC)
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MultiView Navigator
Find / Search

Search for Instances, Nets or Ports
Wildcard (*) Matching
Advanced Options - Choice of Log Window Pane for Search Results

Cross-probing from Find Tab to the other Four Windows
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MultiView Navigator
Active Lists

“Enables User To Compile Lists Of Important Resources
Instances
Nets
Macros
Regions

Default Lists
Unassigned Instances
Unassigned Pins
Clock Nets

Navigate Thru Design To Find Status Of  Important Design 
Resources
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MultiView Navigator
Viewing Active Lists

Open Default Active Lists from MVN Tools Menu
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MultiView Navigator
Creating Active Lists

Users Can Create New Active Lists

Select instances

Name List



Netlist Viewer
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MultiView Navigator
Netlist Viewer

Displays Netlist in Hierarchical Manner
Explore each Level of Hierarchy and Trace Signals

Search Window –
shows results of 
searches

Schematic View 
Window –
displays a 
graphical 
representation of 
the netlist
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MultiView Navigator
Netlist Viewer (cont.)

Viewing Options
Push, Pop, Jump to Top 
Go to First Page, Go to Last Page, Go to Next Page, Go to Last 
Page 
Right-click on Net to Follow Net to Other Pages or Net Driver

Highlight, Highlight Append, un-Highlight, un-Highlight All
Allows Page Splitting

Allows User to Decide if All Elements on that Level Are Shown as 
Single Page
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MultiView Navigator
Netlist Viewer (cont.)

View Pre- and Optimized Netlists for ProASIC3/E, ProASICPLUS and 
Axcelerator

Pre-optimized Netlist Is Original Hierarchical Netlist
Optimized Netlist is Flattened

Reflects what other Tools Use (ChipEdit, PinEdit)
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MultiView Navigator
LogicalCone

Helps View Critical Portions of Netlist
Identify Critical Paths using SmartTime
Add this Logic to LogicalCone
Incrementally Add / Remove Logic from Cone
CrossProbe from / to LogicalCone
All NetlistView Features available in LogicalCone
LogicalCone Tab in Hierarchy Window
LogicalCone Menu Accessible from NetlistViewer
Can Simultaneously Create Multiple Cones
Set of Macros Can Be Highlighted, then Added to Cone
LogicalCone Data No Longer Valid after Recompile



Actel Corporation Confidential © 2009 298

LogicalCone
User Interface
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LogicalCone



I/O Attribute Editor
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MultiView Navigator 
I/O Attribute Editor

Input/Output Attribute Editor
Select (Varies by Family):

I/O Standard
I/O Threshold
Slew Rate
I/O Power-up State

Enter Load Capacitance
Does Not Change SDF File 
Generation

Spreadsheet-like Sort, Copy, 
Paste
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MultiView Navigator 
I/O Attribute Editor (cont.)

With multiple rows selected, changing the 
value of a drop-down item with CTRL key 
pressed will change the value for all rows

Hold down CTRL key to 
select multiple rows

Double click on column to sort display by 
that column 
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MultiView Navigator
Package Pins View

Package Pins View Shows All Pins on Package 



Pin Editor
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Pin Assignment Options

I/O Locations Can Be Assigned as Follows:
Automatically by Designer Software during Layout
By Importing a Physical Design Constraint (.pdc) File
Manually using PinEdit and I/O Attribute Tools in Designer

Pin Assignments May Be Exported for Later Use
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MultiView Navigator
PinEditor

Graphical Pin Location Editor
Drag and Drop Placement of Pins
Fix Pin Locations for Subsequent Place and Route Runs

Flip Display
Enables Assignments as if Looking from Top or Bottom of Chip

Assign I/O Bank Properties for ProASIC3E, Fusion and IGLOOe
Pinout Can Be Printed for Documentation

Right
Mouse
Click!
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I/O Bank Configuration
ProASIC3E, Fusion and IGLOOe

I/O Bank 
Configuration

Select Bank
Select I/O Standards

Incompatible Options
Disappear when 
Selecting I/O 
Standards

Select Low-power 
Mode
Select Input Delay

Select bank

I/O standards

I/O bank 
VCCI/VREF  
not editable
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VREF Pin Assignment
Axcelerator, ProASIC3E, Fusion and IGLOOe

Select Package Pin And Click Right Mouse Button
Select “Use Pin for VREF”

Right
Mouse
Click!
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Designer
Automatic I/O Bank Assignment

I/O Bank Assigner for Axcelerator, ProASIC3/E, Fusion  and 
IGLOO/e

Runs automatically during layout
Is available when at least one I/O bank is unassigned
Automatically assigns voltages to I/O banks that do not have I/Os 
assigned

Fills them with compatible I/Os
Assigns VREF pins if required
Respects manual assignment already in place 
Maintains placement quality and performance

No impact on device performance
Can be controlled manually from within the MultiView Navigator
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Pin Assignment Recommendations

Enter Design as Completely as Possible
Don’t Worry about Functionality

Compile (Ignore Warnings) and Layout
“Fix”All Pin Assignments 

Edit > Select All then Edit > Fix
Send Pin Report to PCB Layout
Continue Working Out Bugs

Future Layouts Will Honor “Fixed” Assignments



Chip Planner
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ChipPlanner

Editing and Floorplanning Support for:
Fusion, ProASIC3/E, IGLOO/e, ProASIC3L, ProASICPLUS, 
ProASIC, Axcelerator, eX, SX-A and SX-S Families
Use ChipEditor for All other Actel FPGA Families

ChipPlanner Capabilities:
Editing

Place, Unplace, or Move Logic and I/O
View Macro Placements Made during Layout
View Net Connections with Ratsnest or Route View
View Architectural Boundaries
View and Edit Silicon Features, such as I/O Banks
View Placement and Routing of Paths when Used with SmartTime

Floorplanning
Create and Assign Logic or Nets to Regions

Cross-probe with Silicon Explorer to Select Probes
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ChipPlanner Terminology

Region
Defined sub-Portion of Die
Shapes - Rectangular or Rectilinear (Union of Rectangles)
Types:

Empty - No Logic Can Be Put into this Region 
Inclusive - Assigned Logic Must Be Put into this Region

Other Unassigned Logic Can Be Added to this Region by Layout
Exclusive - Only Assigned Logic Can Be Put into this Region

Not Supported for APA or A500K
Assign

Place Logic into Particular Region or Location
Similar to “Place” in ChipEditor

Lock
Finalizes Allocation of Logic in Particular Location

Similar to “Fix” in ChipEditor
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ChipPlanner
Editing and Floorplanning

Drag Logic or I/O to Desired Location
ChipPlanner Floorplanning Functions

Create Logic Region
Create Empty Region
Select Region
Move Region
Delete Region
Resize Region
Assign/Unassign Logic to Region

Regions Can Span Logic, Memory Cells and I/O

Create empty region

Create inclusive region

Create exclusive region

Delete region

Assign / 
Unassign

Create local clock region
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ChipPlanner
Empty Region

Region > Create Empty
No Logic Assigned to Empty Regions
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ChipPlanner
Inclusive Region

Region > Create Inclusive
Assigned Logic Put in Inclusive Region

Other Logic May also Be Put in this Region
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ChipPlanner Exclusive Region
ProASIC3/E, ProASIC3L, Fusion, IGLOO/e

Region > Create Exclusive
Only assigned logic placed in exclusive region
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ChipPlanner Quadrant Clock Region
ProASIC3/E, ProASIC3L, Fusion, IGLOO/e

Region > Create QuadrantClock
Graphically Assign net to a Quadrant Clock
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Quadrant Clock Region PCD Constraint
ProASIC3, ProASIC3L, Fusion, IGLOO

Create Quadrant Clock Regions with PDC Constraint
PDC Syntax:

assign_quadrant_clock -net netname -quadrant quadrant_clock_region [-fixed 
value]
quadrant_clock_region is UL, UR, LL, LR

Quadrant Clock Region LL
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ChipPlanner
Region Color Control

Individual Region Color Control
Regions Have Different Default Colors Based on Types
Can Change Each Region’s Default Color
Region Colors Saved in .adb File
Region Colors Reset to Defaults upon Recompile
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ChipPlanner
Region Properties

Region > Properties
Indicates:

Region Type
Region Width, Height and Origin
Region Usage

Shows Region Default Color
Default Color Can be Changed

Also Provides Access to Assignment 
Window

Region size and utilization

Change region color

Assign logic to region
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ChipPlanner
Logic Assignment

Two Logic Assignment Methods
Assignment Window (Region > 
Assign/Unassign Logic…)

Provides Search and Selection 
Capability
Also Available from Region Properties 
Dialog Box

Drag and Drop Logic into Region
Checkmark Indicates Assigned Logic
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ChipPlanner
Display Settings

Users Can Show/Hide Object and 
Assign Color to Resource

View > Display Settings
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ChipPlanner
Viewing Nets

Select Net View Options from Nets Toolbar:
Display No Nets

Display Input Nets

Display Output Nets

Display Input and Output Nets

Display Ratsnest or Routes (All supported devices)

Hide nets

Show inputs only
Show outputs only

Show Ratsnest

Show routesShow nets

View Ratsnest View Routes
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ChipPlanner
Highlighting Nets

Selected Nets Can Be Highlighted to Aid 
Analysis

Select Net from Design Window Nets Tab or Search 
Results
Change Highlight Color from Toolbar or Edit Menu

Highlight

Unhighlight All

Highlight Color
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ChipPlanner
ProASIC3/E, ProASIC3L, Fusion, IGLOO/e, Axcelerator

Floorplanning Capabilities 
Define Rectangular Regions

Empty, Exclusive and Inclusive Region Support for Axcelerator
Modify Region types (Inclusive / Exclusive)

Assign Logic and Nets to Region
I/O Assignments
PLL and RAM 
Assignments

Drag and Drop 
Assignments
Multi-region 
Assignments
NOT 
Recommended
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Quadrant Clock Region Support
ProASIC3/E, ProASIC3L, Fusion, IGLOO/e

Create Quadrant Clock Regions with PDC or in 
ChipPlanner

PDC Syntax:
assign_quadrant_clock -net netname -quadrant quadrant_clock_region [-fixed 
value]
quadrant_clock_region is UL, UR, LL, LR

Quadrant Clock Region LL
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Local Clock Region Support
ProASIC3/E, ProASIC3L, Fusion, IGLOO/e

ProASIC3/E, IGLOO/e and Fusion Local Clock 
Regions

Created through PDC only
PDC Syntax:

assign_local_clock -net netname -type clock_type clock_region
clock_type is either chip or quadrant
clock_region:

A multi-spine rectangle defined as [T | B]#:[T | B]# 
A single spine defined as T# (Top spine) or B# (Bottom spine) 

T1 T2 T3 T4 T5 T6

B1 B2 B3 B4 B5 B6

A3P400 Local Clock Locations
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Local Clock Region Support
Axcelerator

Axcelerator Local Clock Regions
Created through PDC only
PDC Syntax:

assign_local_clock –type routing_resource_type –net netname
<local_clock_region> [local_clock_region] [local_clock_region] …
routing_resource_type is either hclk or rclk
local_clock_region is Hierarchical Resource Name of Specific Clock Region

Tile3C.Row0

Tile 3A

Tile1C.RowN-1

A          B           
C

3      2       
1

Tile3b.colN-1
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Hands-on Labs 5 and 6

Complete Labs 5 and 6 in the Lab Guide
Lab 5

Open Designer and Compile Design
Save your Work

Lab 6
Use PinEditor to Make pin assignments
Export Pin Report



Entering Timing Constraints
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Timing constraint flow

Note: these files are not the same!
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Timing Requirements / Exceptions

Timing Requirements Are:
Clock Frequency
Input Delay
Output Delay

Timing Exceptions Are:
Multi-cycle Paths
False Paths
Maximum Delay
Minimum Delay

Timing Requirements And Exceptions:
Direct Synthesis Mapping 
Guide Place and Route and Timing Analysis of a Design
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Timing Constraints
Clock Frequency

Clock Constraints Define the Timing Requirements Between 
Flip Flops For Each Clock Network
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Timing Constraints
Input Delay

Input Delay Specifies When a Signal Arrives at The Input 
Ports of the FPGA

Referenced from the Launch Edge Outside the FPGA

Input Delay
CK

Clock 
Generator
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Timing Constraints
Output Delay

Output Delay Specifies When the Arrives at the Input Ports 
of Another Device

Referenced to the Capture Edge Outside the FPGA

CLK

3.0ns

Clock 
Generator

CK

MyFPGA
OUT1
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Timing Exceptions
Multi-cycle Paths

Multi-cycle Paths Are Paths Where the Allowable Data Path 
Delay is More Than One Clock Cycle

CKFF1

CKFF3

New setup relationshipDefault setup relationship

F
F
3

F
F
3

Current Design

Clock 
Generator

F
F
1

F
F
1

CK
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Timing Exceptions
False Paths

False Paths are Design Paths That are Ignored for 
Optimization and Timing Analysis  
A Path May be False Because:

It Doesn’t Propagate Data Forward 
The Circuitry Involved Will Operate Slower Than The Constraints 
Indicate

For Example, Test Logic May Be Operated At A Lower Frequency 
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Synplicity SDC File

Synplicity Generates an SDC Constraint File That can be 
Imported Into Designer

Constraint file is visible on Libero File Manager tab

# Top Level Design Parameters
# Clocks
create_clock -period 10.000000 -waveform {0.000000 5.00000} CLK

# False Paths Between Clocks

# False Path Constraints

# Maximum Delay Constraints

# Multicycle Constraints

# Virtual Clocks
# Output Load Constraints
# Driving Cell Constraints
# Wire Loads
# set_wire_load_mode top

# Other Constraints
set_input_delay 3.500 -clock CLK {EN}
set_input_delay 3.500 -clock CLK {RST}
set_output_delay 4.000 -clock CLK {Q(0)}
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Importing SDC Timing Constraints

SDC Timing Constraints can be Imported into Designer as 
Source File From Libero

Libero Automatically Sends Timing Constraints to Designer
Specify Constraint file from Libero Menu

Project > Files Organization > Designer Constraint files

Select <name>_sdc.sdc
then click Add
DO NOT select 
<name>_syn.sdc
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SmartTime Overview

SmartTime is Actel’s Static Timing Analysis Tool for:
ProASIC3, ProASIC3L, Fusion, IGLOO, APA and 500K
SX-A, RTSX-S, eX, AX, RTAX-S
All Future Products
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SmartTime Features

Graphical Constraint Entry
SDC Constraint Support
SDC Constraint Checker
Analysis

Cross-clock Domain Analysis
Flexibility in Clock Domain Selection

Improved Ease-of-Use
Separate Constraint & Analysis Views

Separate Maximum & Minimum Analysis Views
Clock Domain Browser for the Analysis View

Visual Constraint Dialogs
Customizable Timing Information for the Paths List
Constraint Entry from the Analysis Window
Customizable Timing Reports
Filtering Capabilities
Persistence of User Settings
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SmartTime
Supported SDC Constraints

Timing Requirements and Exceptions can be Entered
From a Synopsys Design Constraint (SDC) File or
The SmartTime Visual Dialog GUIs

SDC Constraints Supported in SmartTime: 
create_clock
create_generated_clock
set_clock_latency
set_input_delay
set_output_delay
set_load
set_false_path –from –through –to
set_ multicycle_path –from –through –to
set_ maximum_delay –from –through –to
set_ minimum_delay –from –through –to
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SmartTime Windows

SmartTime Includes of Separate Constraint Editor and 
Timing Analysis Windows

Constraint Editor – GUI Based Constraint Entry
Timing Analyzer Provides Delay Information

Click to launch 
SmartTime
Constraint Editor 
or Analysis Views
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SmartTime
Constraints Editor

Use Constraints Editor to:
Enter or Edit Timing Requirements:

Clock Frequency, Clock Latency, Input and Output Delays
Enter or Edit Timing Exceptions:

Max Delay, Multicycle Paths, False Paths
Browse Clock Domains

Constraints are grouped as Requirements and Exceptions
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SmartTime Toolbar

The SmartTime Toolbar Contains Commands for 
Performing Common Operations.

Tool Tips Are Available for Each Button.

Commit

Print

Copy

Paste

Edit current 
constraint

Delete 
selected 

constraints

Undo

Redo

Max delay 
analysis View

Timing 
constraint 

View

Recalculate 
All

Min 
delay 

analysis 
View

Add clock 
constraint

Add input   
delay 

constraint

Add output 
delay 

constraint

Add false      
path constraint

Add max delay 
constraint

Clock domain 
manager

Path set 
manager

Check timing 
constraints

New multicycle
clock constraint

Add clock source 
latency

Add generated 
clock constraint
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SDC Constraints in SmartTime

Path to constraint file



Clock Constraints
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SmartTime Clock Domains

SmartTime Detects Possible Clocks by Tracing Back from 
the Clock Pins of all Sequential Components Until it Finds:

An Input Port
The Output of Another Sequential Element, or 
The Output of a PLL

SmartTime Classifies Clock Sources Into Three Types:
Explicit Clocks
Potential Clocks
Clock Network

Each Clock Domain Contains at Least 3 Path Sets:
Register to Register
External Setup or Hold
Clock to Out
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SmartTime Constraint Entry

Enter Timing Requirements Prior To Layout For Timing 
Analysis And To Guide Layout Engine

Clock Frequency, Input and Output Delays
Timing Exceptions Can Be Entered After Layout If Negative 
Slack Exists To Ensure Correct Timing Analysis

Max Delay, Multicycle Paths, False Path

Double-click constraint type to add constraint or 
use SmartTime menu
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Entering Clock Constraints

Visual Constraint Dialog Box Simplifies Constraint Entry

Select Clock Source 
from pull-down Menu

Enter Period or Frequency

Enter Offset and 
Duty Cycle

Select Launch Edge
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SmartTime Clock Constraints

Clock Constraints in Constraint Editor
Select Constraint to Add, Edit or Delete

Double-click to edit constraint

Indicates if source of 
constraint is the 
SmartTime GUI or SDC 
file
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SmartTime Generated Clock Constraints

Constraints For Internally Generated Clock Can Be 
Specified Using Generated Clock Constraints

Useful For Constraining Designs with Clock Dividers

clk_in

+

÷3

d_in1[3:0]

d_in2[3:0]

d_out[3:0]

100MHz
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Entering Generated Clock Constraints

Visual Constraint Dialog Box Simplifies Constraint Entry

Select Reference 
Clock from pull-down 
Menu

Enter Multiplier and 
Divider

Enter clock name
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clk_in

+

÷3

d_in1[3:0]

d_in2[3:0]

d_out[3:0]

100MHz

SmartTime Generated Clocks
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SmartTime
Automatic Creation of Generated Clocks

Automatic Creation of Generated Clock Constraint Based on 
Static Configuration of PLLs for Fusion, ProASIC3, IGLOO, 
AX, RTAX-S
No Effect Unless the Reference Clock is Constrained

auto-generated
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Specify Delay When Clock is Generated Outside the 
Design
Specify Clock Jitter

Clock Source Latency can be Attached to any Clock 
Constraint (Internal or External)

Clock Source Latency:
Definition
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Clock Source Latency:
Constraint Specification

Specify Clock Insertion Delay and Jitter
Specify Early and Late Times for Rising and Falling Edges
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SmartTime
Virtual Clocks

A Virtual Clock has no Associated Source
Used to describe clocks outside the FPGA that have an impact on 
timing analysis inside the FPGA

Clock Analysis for Virtual Clocks
Specify a constraint for a clock that is running outside the FPGA and 
do timing analysis on the design as it interacts with this “virtual”
circuitry



Input and Output Delay Constraints
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SmartTime
Input Timing Constraints

Input Timing Constraints can be Entered as Input Delay or External Setup/Hold
Input Delay – Delay in Terms of Delay Budget Outside FPGA (Default)

Referenced from the Launch Edge Outside the FPGA
Generally Used by Synthesis Tools

External Setup / Hold – Specify Input Delay Budget Inside FPGA
Referenced to the Capture Edge Inside the FPGA 
Used by Previous Actel Timer

Input Delay

Clock 
Generator

External SetupCK
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Select Input Port

Input Delay is the default

Input Constraints
Input Delay

Visual Constraint Dialog Box Simplifies Constraint Entry

Enter Min and Max 
delay or same value 
for both
Minimum Delay for 
analysis only

Select Clock Port 
and Reference Edge
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Input Delay Constraints
External Setup / Hold

Select Input Port

Select Clock Port

Enter Hold 
Requirement

Select External Setup/Hold

Enter Setup 
Requirement
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Input Delay / External Setup
What do These Constraints Mean?

Period = 13.9 ns

Input delay = 5 ns;
Input arrives 5 ns after launch edge

5 ns

Input Delay

External Setup
Period = 13.9 ns

External setup = 8.9 ns;
Data arrives 8.9 ns before capture edge

5 ns 8.9 ns
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SmartTime
Output Delay Constraints

Output Delay Defines the Delay of an Output Relative to a Clock 
Clock-to-Output: Specifies the Output Delay Timing Budget Inside the 
FPGA (default)

Referenced from the Launch Edge Inside the Current Design
Output Delay: Specifies Output Delay Timing Budget Outside the FPGA

Referenced to the Capture Edge Outside the Current Design 
Used by Synthesis tools

Clock-to-Output Output Delay
Clock 
Generator

CK

MyFPGA
OUT1
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Output Constraints
Clock-to-Output

Select Output Port

Select Clock Port

Enter Min and Max 
delay
Minimum Delay for 
analysis only

Clock-to-Output is the Default
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Output Delay Constraints
Output Delay

Select Clock Port

Minimum Delay

Maximum 
Delay

Select Output Delay Select Output Port
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Clock to Output / Output Delay
What do These Constraints Mean?

Clock to Output Period = 13.9 ns
7 ns

Clock to output = 6.9ns;
Output arrives 6.9 ns after launch edge

6.9 ns

Output Delay Period = 13.9 ns
7 ns

Output delay = 7ns;
Output arrives 7 ns before capture edge



Timing Exceptions
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Timing Exceptions
False Paths

The False Path Constraint Removes Timing 
Requirements on Specified Paths

Starting Points Are Input Ports or Register Clock Pins 
Ending Points Are the Register Data Pins or Output Ports

False Paths Are Not Considered During the Timing 
Analysis
False Path Constraints Take Precedence Over Multiple 
Cycle Path Constraints and Overrides Maximum Delay 
Constraints
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SmartTime
Entering False Path Constraints

Specify From, To, Through Pins
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False Path Constraint
Source Pins

Specify Starting Point for False Path

Filter pin names

Add or remove pins 
from source list
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False Path Example

Multiplexer S Input Selects Test / Normal Modes
Paths through MX0:A are False Paths
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False Paths in Constraint Editor

False Path Constraint in Constraint Editor
Select Constraint to Add, Edit or Delete
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Timing Exceptions
Multicycle Paths

The Multicycle Path Constraint Overrides the Single Cycle 
Timing Requirement Between Sequential Elements

The Number of Clock Cycles for Setup or Hold Check Is Specified 
in the Constraint

False Path Constraints Take Precedence Over Multicycle
Path Constraints

CKsource

CKsink

Multicycle path setup relationshipDefault setup relationship



Actel Corporation Confidential © 2009 376

SmartTime
Entering Multicycle Path Constraints

Specify Path Multiplier and From, To, Through Pins
Add Path Multiplier

Browse for From, Through 
or To pins

Specify different multiplier for 
setup analysis and hold analysis
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Timing Exceptions
Maximum Delay

The Max Delay Constraint is Used to Specify The 
Maximum Delay for Timing Paths in The Design
Max Delay is a Timing Exception and Overrides The 
Timing Requirement Between Flip Flops

Maximum Delay Involving Registers Takes Clock Insertion and 
Setup/Hold Delays Into Account

Max Delay Can Also be Used to Constrain Combinatorial 
Input to Output Paths
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Timing Exceptions
Maximum Delay

Specify Maximum Delay Constraint
Overrides Clock Constraint

Browse for From, Through 
or To pins

Enter Max Delay
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Timing Exceptions
Minimum Delay

Specify Minimum Delay Constraint
Overrides Clock Constraint

Browse for From, Through 
or To pins

Enter Min Delay



SmartTime Constraint Wizard



Actel Corporation Confidential © 2009 381

SmartTime Constraints Wizard

Step by Step 
Guidance to 
Create Timing 
Constraints

Overall Clock
Overall I/O
Specific Clocks
Generated Clocks
Specific Inputs
Specific Outputs

Summary 
Displays all 
Constraints 
Entered

Opening the Constraint Wizard: Tools > Constraint Wizard



Actel Corporation Confidential © 2009 382

SmartTime Constraints Wizard
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Exporting SDC Timing Constraints

Constraints Entered in SmartTime GUI Can Be Exported 
from Designer
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Constraint Recommendations

Set Realistic Constraints

Set Sufficient Constraints

Don’t Over constrain
Improperly-Constrained Design Can Lead to Long Run Times, 
Multiple Iterations and/or Sub-optimal Results

Enter any Known Exceptions
Exceptions can be Added During Timing Analysis



Designer Layout Options
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Layout

Assign Physical Locations to Unassigned I/Os
Place Logic Modules 
Assign Routing Tracks to Nets 
Calculate Detailed Delays for All Paths
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Layout Options
ProASIC3, ProASIC3L, Fusion, IGLOO

Layout Mode
Timing-Driven: Constraints Defined in 
SmartTime
Power-Driver: Reduces Power 
Consumption

Incremental Placement and Routing
Multi Pass Layout Option

P&R Runs Multiple Times
Specify:

Number of Iterations
What to Optimize (Specific Clock, Timing 
Violations, Total Power)
Which Results to Save (Best or All)

Advanced Layout Options
Known Limitations

Router Cannot Run in Incremental 
Mode if there Has Been Change in 
Global Assignments

Users Must Manually Uncheck 
Incremental Routing Option and Re-run 
Layout
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Advanced Layout Options
ProASIC3 ProASIC3L, Fusion, IGLOO

High Effort Layout Mode
Placer uses additional netlist
optimizations to improve performance 
(up to 10% QOR increase)
Layout runtime will increase (average 
2x) 
Can combine this option with the Multi-
Pass mode to achieve the best possible 
performance

Repair Minimum Delay Violations
An additional route is performed that 
attempts to repair paths that have 
minimum delay and hold time violations
Done by increasing the length of routing 
paths and inserting routing buffers to 
add delay to paths

No additional tiles or modules are 
inserted

The amount of delay inserted is limited
Best suited to repair paths with small (0 
to 3 ns) hold and minimum delay 
violations 
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Sequential Optimization

Power-driven + High-effort + Sequential optimization
8.4

No-op
Otherwise, SEQ tiles increase by 6.5% on average
High-effort itself reduces COMB tiles by 6.1% on average

8.4_SP1
Remove duplicate registers that are driven by the same net

SEQ tiles reduce by 3.3% on average
8.5_SP1

Perform forward retiming of registers towards output I/Os
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Designer Power-driven Layout
ProASIC3, Fusion, IGLOO, Axcelerator

Layout Optimization Reduces Power Consumption
Reduces net capacitance based on estimated activities

Re-places instances and Optimizes Clock Tree distribution
Average ~18% reduction in net power

Up to 50% in some designs. Includes clocks and regular nets
Average ~13% reduction in total power

Up to 33% in some designs. IGLOO designs with 5pf output load and LVCMOS 
1.5V I/Os

Little to no effect on timing performance
Typically less than -2% 

Timing-driven place and route only Power-driven place and route
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Quadrant Clock Assignment
ProASIC3, Fusion, IGLOO

Finds And Creates Legal Clock Assignments for Clock nets not 
Already Assigned by the User
Runs Automatically As Part Of Layout
Performs Auto-assignment of nets Given Certain Criteria

Runs when > 6 globals (or > 2 PLLs are detected)
Globals come from user netlist or PDC constraints

CCC macro instantiation
Global promotion through PDC constraints

If > 6 global nets, LCA will assign the global nets to 
Chip wide globals or
Quadrant regions 

The choice of chip wide globals or a quadrant region will depend on
Fanout of the nets
Resources and user constraints
Shared loads
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Layout Options
ProASICPLUS

Layout Mode
Timing-Driven: Constraints Defined in 
SmartTime

De-selecting Causes Standard Layout 
to be Used

Place and Route Tools
Can Be Turned On or Off

Incremental Placement and Routing
Lock Existing Placement:  Treats All 
Unchanged Macros as Fixed 
Placements

Multi Pass Layout Option
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Layout Options
Axcelerator

Layout Mode
Timing-Driven

Constraints Defined in SmartTime
De-selecting Causes Standard Layout to 
Be Used

Power Driven
Incremental Placement and Routing

Lock Existing Placement:  Treats All 
Unchanged Macros as Fixed 
Placements

Placement Effort Level
Provides Degree of Control over 
Timing-Driven Placement Engine
Range is from “Low” to “High”

Multi Pass Layout Option
Repair Minimum Delay Violations
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Layout Modes
SX Architecture

Layout Mode
Timing-Driven: Constraints Defined in 
SmartTime (SX-A) or Timer (SX)

De-selecting Timing-Driven Layout Selects 
Standard Layout

Incremental Placement
Lock Existing Placement: Treats All 
Unchanged Macros as Fixed Placements

De-selecting Allows Placer to Relocate 
Unchanged Macros if Necessary

Multiple Passes
P&R Runs Multiple Times

Advanced Options Allow Additional 
Control of Timing-driven Placement Engine

SX, SXA and eX Families
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Which Layout Mode to Use?

Are estimates 
well within 

design specs
?

Analyze the pre-layout estimates

No constraints needed
(Use Standard Mode Layout)

Apply constraints within 
SmartTime (or Timer) and 
Use Timing-Driven Layout

Are estimates
within 15% of
design specs

?

Yes

Yes

No
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Completed Layout



Designer Files and Reports
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Exporting Files

Supported File Types (File>Export)
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Exporting Files - Cont.
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Exporting Pin Report

Pin Report Can be Exported from Designer
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Exporting Pin Constraint File

Pin Constraint File Can be Exported from Designer

File Type
File 
Extension Family

PIN file *.pin

ACT1, ACT2, 
ACT3, MX, XL, 
DX, SX, SX-A, 
eX

Gatefield Constraint file *.gcf
ProASIC,              
ProASIC PLUS

Physical Design Constraint *.pdc

Axcelerator, 
ProASIC3\E, 
Fusion
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Exporting IBIS File
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IBIS File

Die/Package choice based on the design

Customized PIN list with corresponding 
model names and signal names

More on IBIS later in the week . . .



Post-Layout Timing Analysis
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Timing Analysis

Timing Terminology 
Timing Analysis with SmartTime
SmartTime Timing Reports
Reference



Timing Terminology
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Timing Terminology:
Arrival Time

Arrival Time is the Sum of:
The Clock Network Delay to the Source Flip-Flop
The Delay from the Source Flip-Flop to the Destination Flip-Flop 

CK
0 20

FF2:D Arrival Time

FF2FF2FF1FF1

CK

D

CPCP

40

FF1:CP – FF2:D

2
0

= 30

FF1:CP
10

CK–FF1:CP

10
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Timing Terminology:
Required Time

Required Time is:
Clock Period Plus Clock Network Delay to Destination Flip-Flop
Minus the Setup Requirement for the Destination Flip-Flop

CK
0 20

FF2FF2FF1FF1

CK

D

CPCP

FF2:D Required Time

40

FF2:CP

CK-FF2:CP

15

= 33- Setup Requirement

2

35
FF1:CP

10
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Timing Terminology:
Slack

Slack = 
Required Time – Arrival Time (setup check)
Arrival Time – Required Time (hold check)
Violation of Slack < 0

Ck
0 20

FF2:D Arrival Time

FF2FF2FF1FF1

CK

D

CPCP

FF2:D Required Time

40

FF2:CP

FF1:CP – FF2:D

2
0

15

CK-FF2:CP

= 30
= 33

= +3

-- Setup Requirement

2

35
FF1:CP

10

CK–FF1:CP

10

slack



Timing Analysis with SmartTime
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Timing Analysis with SmartTime

Design Summary
Maximum Delay Analysis View
Minimum Delay Analysis View
Cross Clock Domain Analysis
Removal and Recovery Checks
SmartTime Scenarios
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SmartTime Analysis View
Design Summary

Performance Summary is Displayed in Maximum and 
Minimum Delay Analysis View

√ - Indicates Timing Requirements Met for That Domain
X – Indicates There Are Violations Within the Domain
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Timing Analysis with SmartTime

Design Summary
Maximum Delay Analysis View
Minimum Delay Analysis View
Cross Clock Domain Analysis
Removal and Recovery Checks
SmartTime Scenarios
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Maximum Delay Analysis View
Register to Register Path Set

Identify Internal Setup Violations

Path list

Path details

Domain browser
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Maximum Delay Analysis View
Register to Register Path Set (cont.)

Verify Internal Timing Requirements and Identify Paths With Violations 
By Default The Register to Register Path Displays: 

Source Pin And Sink Pin – Beginning And Ending Points For Delay 
Calculation
Delay – Path Delay From The Clock Pin Of The Source Flip-flop To The 
Input Of The Destination Flip-flop
Slack – Required Time – Arrival Time
Arrival – Delay From The Launch Edge At The Source Flip-flop To The 
Data Input Of The Destination Flip-flop
Required – Time Data Must Be Valid To Avoid A Timing Violation; 
Calculated From Clock Period And Setup Requirement For Destination 
Flip-flop
Setup – Setup Time Requirement For The Destination Flip-flop
Minimum Period – Minimum Clock Period To Avoid A Timing Violation
Skew – Clock Insertion Delay To The Source Flip-flop Minus The Clock 
Insertion Delay To The Destination Flip-flop

Timing Information  For Each Type Of Set Can Be Customized



Actel Corporation Confidential © 2009 416

SmartTime
Internal Setup Check

Setup Check is Displayed in Maximum Delay Analysis 
View in Register to Register path set

Setup Check Calculation
Arrival time = Launch edge (0) +  max Clock to FF1 + max Data path
Required time = Capture edge (T) + min Clock to FF2 – Setup of FF2
Slack = Required – Arrival = Violation if < 0

Setup check
launch edge

Setup check
capture edge
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Setup Check in SmartTime

Setup Check
Arrival time = Launch edge (0) +  max Clock to FF1 + max Data path
Required time = Capture edge (T) + min Clock to FF2 – Setup of FF2
Slack = Required – Arrival = Violation if < 0
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Clock Source Latency: Analysis

Pin Name Type Net Name Cell Name Op Delay (ns) Total (ns) Fanout Edge
From: irci:CLK
To: iry1:D
data required time 6.566
data arrival time - 8.285
slack -1.719

clk 0.000 0.000
Clock source latency + 0.500 0.500 r

irci:CLK Clock network + 5.573 6.073 r
irci:Q cell ADLIB:DFEG + 0.673 6.746 1 r
iadd2/add0_FCINST1:A net rci + 0.151 6.897 r
iadd2/add0_FCINST1:FCO cell ADLIB:FCINIT_BUFF + 0.543 7.440 1 r
iadd2/add0:FCI net iadd2/add0_FCNET1 + 0.000 7.440 r
iadd2/add0:FCO cell ADLIB:ADD1 + 0.075 7.515 1 r
iadd2/add1:FCI net iadd2/c0 + 0.000 7.515 r
iadd2/add1:S cell ADLIB:ADD1 + 0.610 8.125 1 r
iry1:D net sy[1] + 0.160 8.285 r
data arrival time 8.285

clk Clock Constraint 4.000 4.000
Clock source latency + -0.250 3.750 r

iry1:CLK Clock network + 3.050 6.800 r
iry1:D Library setup time ADLIB:DFEG - 0.234 6.566
data required time 6.566

Data arrival time calculation

Data required time calculation

Late
Launch

Early
Capture
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Setup Check w/ Multicycle Path

SmartTime Uses Multicycle Path Constraint in Setup Check

Setup Check Calculation
Arrival time = Launch edge (0) +  max Clock to FF1 + max Data path
Required time = Capture edge (2T) + min Clock to FF2 – Setup of FF2
Slack = Required – Arrival = Violation if < 0

Setup check
launch edge

Setup check
capture edge
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Setup Check w/ Multicycle Path

Setup Check
Arrival time = Launch edge (0) +  max Clock to FF1 + max Data path
Required time = Capture edge (2T) + min Clock to FF2 – Setup of FF2
Slack = Required – Arrival = Violation if < 0
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SmartTime
External Setup Check

External Setup Defines the Timing Requirements at the Input Pins
External Setup Check is Displayed in the Maximum Delay Analysis 
View for Each Clock Domain

CLK

DATA

Flip-Flop

Gate-A
Inst A1

D

CLK Global Clock 
Network
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SmartTime External Setup Check
No Input Constraints

External Setup Check
Arrival time = max Input Pad to FF
Required time = Capture edge (T) + min Clock to FF - Setup of FF
External Setup = Arrival - Required
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SmartTime External Setup Check
Using Input Delay Constraint

Enter Constraint as Input Delay
Delay is referenced to launch edge of clock
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SmartTime External Setup Check
Using Input Delay Constraint

External Setup Check Calculation
Arrival time = Input Delay Constraint + max input delay to FF
Required time = Capture edge (T) + min Clock to FF – Setup of FF
Slack = Required – Arrival = Violation if < 0
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SmartTime External Setup Check
Using External Setup Constraint

Enter Constraint as External Setup/Hold
Delay is referenced to capture edge of clock
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External Setup Check w/ External Setup 
Constraint

External Setup Check Calculation
Arrival time = Launch edge (0) + max input delay + max Data path
Required time = External Setup + min Clock to FF1 – Setup of FF1
Slack = Required – Arrival = Violation if < 0
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SmartTime
Clock to Output Check

Clock to Output is Displayed in the Maximum Delay Analysis View for 
Each Clock Domain

Clock to Output Calculation
Arrival time = Launch edge (0) + max Data path
Required time = Capture edge (T)
Slack = Required – Arrival = Violation if < 0

CLK

DATA

Flip-Flop

Output

Clock Global Clock 
Network

Gate-A
Inst A1
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Clock to Output Check w/ Output Delay 
Constraint

Enter Constraint as Output Delay
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Clock to Output w/ Output Delay Constraint

Setup Check
Arrival time = Launch edge (0) + max Data path
Required time = Capture edge (T) – Output Delay
Slack = Required – Arrival = Violation if < 0



Adding Timing Exceptions
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False Path Example

Multiplexer S Input Never Changes
FF1, FF2 and FF3 to FF4 through MX0:A are False Paths

S input always 1
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SmartTime
Maximum Frequency
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SmartTime
Timing Analysis

Timing Violation
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Timing Analysis
Expanded Path

This is a false path
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SmartTime
Entering False Path Exceptions

Right
Mouse
Click!
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Add False Path Exception

False Path Constraint Through MX0:A

False Path
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SmartTime
Maximum Frequency with False Paths

Actual Operating Frequency
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SmartTime
Expanded Path Timing Information

Right-click a Path in the Path List Displays the Expanded 
Path in a Separate Window
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SmartTime
Expanded Path (cont.)

Expanded Path View Includes a Schematic of the Path

Right click 
in window 
to zoom



Actel Corporation Confidential © 2009 440

Timing Analysis with SmartTime

Design Summary
Maximum Delay Analysis View
Minimum Delay Analysis View
Cross Clock Domain Analysis
Removal and Recovery Checks
SmartTime Scenarios
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Minimum Delay Analysis View
Register to Register Path Set

Identify Internal Hold Violations

Path list

Path details

Domain browser
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SmartTime
Hold Check

Hold Check is Displayed in the Minimum Delay Analysis View

Hold Check Calculation
Arrival time = Launch edge (0) +  min Clock to FF1 + min Data path
Required time = Launch edge (0) + max Clock to FF2 + Hold of FF2
Slack = Arrival – Required = Violation if < 0

Hold check
launch edge
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SmartTime
Hold Check (cont.)

Hold Check
Arrival time = Launch edge (0) +  min Clock to FF1 + min Data path
Required time = Capture edge (0) + max Clock to FF2 + Hold of FF2
Slack = Arrival – Required = Violation if < 0
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SmartTime
External Hold Check

External Hold Defines the Timing Requirements at the Input 
Pins
External Hold Check is Displayed in the Minimum Delay 
Analysis View for Each Clock Domain

External Hold Check Calculation
Arrival time = min Input Pad to FF1
Required time = max Clock to FF1 + Hold of FF1
External Hold = Arrival - Required

CLK

DATA

Flip-Flop

Gate-A
Inst A1

D

CLK Global Clock 
Network
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SmartTime
External Hold Check

External Hold Check – Minimum Delay Analysis View
Arrival time = min Input Pad to FF1
Required time = max Clock to FF1 + Hold of FF1
Slack = Arrival – Required = Violation if < 0

Slack cannot be 
calculated if clock 
constraint is not 
entered
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Timing Analysis with SmartTime

Design Summary
Maximum Delay Analysis View
Minimum Delay Analysis View
Cross Clock Domain Analysis
Removal and Recovery Checks
SmartTime Scenarios
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SmartTime
Cross-Clock Domains

SmartTime Performs Setup Check Across Clock Domains
SmartTime Looks at the Relationship Between the Active Clock Edges Over a Full 
Repeating Cycle, Equal to the Least Common Multiple of the Two Clock Periods
For Each Capture Edge at the Destination Flip-flop, SmartTime Assumes That the 

Corresponding Launch Edge Is the Nearest Source Clock Edge Occurring Before the 
Capture Edge

Repeating cycle

setup1 setup2
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SmartTime
Cross-Clock Domain Analysis Activation

Activate Cross-clock Domain Analysis for a Particular Clock 
Domain

SmartTime Automatically Detects All Other Clock Domains With 
Paths Ending at Selected Clock Domain
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SmartTime
Cross-Clock Domains in SmartTime

Inter clock domain analysis
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Timing Analysis with SmartTime

Design Summary
Maximum Delay Analysis View
Minimum Delay Analysis View
Cross Clock Domain Analysis
Removal and Recovery Checks
SmartTime Scenarios
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Removal/Recovery Checks

Definition
An asynchronous signal should not be de-activated around the active 
clock edge

Recovery needs to be checked in Max delay analysis
Removal needs to be checked in Min delay analysis
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Removal/Recovery Checks: Analysis
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Timing Analysis with SmartTime

Design Summary
Maximum Delay Analysis View
Minimum Delay Analysis View
Cross Clock Domain Analysis
Removal and Recovery Checks
SmartTime Scenarios
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SmartTime Scenarios

Create constraint options for testing
Use for pre-layout timing
Use to drive TDPR

Launch from Tools => Constraints Editor => New Scenario
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SmartTime Scenarios

Brings up Timing Constraints Dialog = “Scenario_1”
Additional Scenarios can be created

Use Constraints Wizard to Enter Constraints
Wizard adds constraints only to the active scenario

Import SDC or Export Scenario with SDC
Scenarios can be Added, Edited, Deleted, Copied 
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SmartTime Scenarios

Use Options => Advanced => Scenarios
Use specific scenario for timing analysis
Use specific scenario for TDPR



SmartTime Timing Reports
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SmartTime
Timing Reports

SmartTime Can Generate Five Types of Reports:
Timing Report
Timing Violation Report
Data Sheet Report
Bottle Neck Report
Constraints Coverage
Combinational Loops
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SmartTime
Timing and Timing Violation Reports

Timing Report Contains Timing Information of the Design in a 
Text Format

Information Can Be Customized
Timing Violation Report Contains a Flat List of Paths With 
Timing Violations (No Breakdown by Clock Domain).
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SmartTime
Timing Report Options
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SmartTime
Timing Report Options

Paths & Sets Options
Include User Defined Sets in Timing Report
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SmartTime
Timing Report Options

Clock Domains
Specify Clock Domains to be Included in the Timing Report
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SmartTime
Timing Report Structure

Header
Design Information, Operating Conditions…

Summary
Data-sheet (Freq, ext setup/hold, min/max clock-to-out…)

Clock Domain Details
Path Sets (reg2reg, in2reg, reg2out, Custom…)

Path Details
Expanded Paths

Inter-clock Domain Details
Pin-to-pin Path

Path Sets (in2out, Custom…)
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SmartTime
Timing Report
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SmartTime
Timing Violations Report Options

General Options
Specify Maximum or Minimum Delay Analysis
Enter Slack Threshold
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SmartTime
Timing Violations Report Options

Path Options
Limit Number of Reported Paths
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SmartTime
Timing Violation Report Structure

Header
Design Information, Operating Conditions…

Paths
List of Paths With Timing Violations
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SmartTime
Timing Violation Report
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SmartTime
Datasheet Report

Content
Pin Description

Pin location on the package
Port name
Type (input, output, inout, clock)
I/O Technology used

DC Timing Characteristics
Electrical parameters of each I/O technology (slew, output load,
voltages,)

AC Timing Characteristics
External Timing Requirements

New analysis view in the SmartTime Analyzer
Report Format

Text format or CSV (Comma Separated Value)
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Datasheet Report
AC Timing Characteristics

Maximum Clock Frequency for all External Clocks
External Setup/Recovery/Hold/Removal for Each Input 
Port with Respect to External Clocks
Clock-to-out for Output Ports
Input-to-Output for Combinational Paths
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Datasheet Report

Pin Description
+-------+----------+--------+-----------+
| Name  | Location | Type   | Techno    |
+-------+----------+--------+-----------+
| a[0]  | J14      | Input  | LVCMOS15  |
| b[0]  | H15      | Input  | LVCMOS25  |
| reset | K1       | Input  | SSTL2I    |
| ci | B8       | Input  | LVTTL (1) |
| clk | R7       | Clock  | GTLP25    |
| y[0]  | C9       | Output | LVTTL (2) |
| co    | B7       | Output | LVTTL (3) |
| en    | L2       | Input  | PCI       |
+-------+----------+--------+-----------+

DC Electrical Characteristics
+-----------+------+----------+-------+-----------+------+--------+------+--------+
| Name      | Vcci | Resistor | Input | Hot       | Vccr | Output | Slew | Output |
|           | (V)  | Pull     | Delay | Swappable | (V)  | Drive |      | Load   |
|           |      |          |       |           |      | (mA)   |      |        |
+-----------+------+----------+-------+-----------+------+--------+------+--------+
| GTLP25    | 2.5  |          | no    | yes       | 1    |      |      |        |
| LVCMOS15  | 1.5  | Up       | no    | yes       |      |      |      |        |
| LVCMOS25  | 2.5  | None     | no    | yes       |      |      |      |        |
| LVTTL (1) | 3.3  | None     | no    | yes       |      |      |      |        |
| LVTTL (2) | 3.3  | None     |       | yes       |      | 24   | Low  | 35     |
| LVTTL (3) | 3.3  | None     |       | yes       |      | 12   | High | 40     |
| PCI       | 3.3  |          | no    | no        |      |      |      |        |
| SSTL2I    | 2.5  |          | no    | yes       | 1.25 |      |      |        |
+-----------+------+----------+-------+-----------+------+--------+------+--------+
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Datasheet Report (cont.)

AC Electrical Characteristics
+-------------------+------------+--------+------------+--------+---------+------+
| Description       |            |        |            | Min    | Max     | Unit |
+-------------------+------------+--------+------------+--------+---------+------+
| Clock frequency   | clk |        |            |        | 189.143 | MHz  |
| Clock period      | clk |        |            | 5.287  |         | ns   |
| Setup time        | a[0]       | before | clk (rise) | -0.946 |         | ns   |
| Setup time        | b[0]       | before | clk (rise) | -2.642 |         | ns   |
| Setup time        | ci | before | clk (rise) | -3.100 |         | ns   |
| Setup time        | reset      | before | clk (rise) | -0.096 |         | ns   |
| Hold time         | a[0]       | after  | clk (rise) | -1.278 |         | ns   |
| Hold time         | b[0]       | after  | clk (rise) | -2.062 |         | ns   |
| Hold time         | ci | after  | clk (rise) | -2.241 |         | ns   |
| Hold time         | reset      | after  | clk (rise) | -0.429 |         | ns   |
| Recovery time     | reset      | before | clk (rise) | -0.266 |         | ns   |
| Removal time      | reset      | after  | clk (rise) | -0.429 |         | ns   |
| Propagation delay | clk (rise) | to     | co         | 3.545  | 7.420   | ns   |
| Propagation delay | clk (rise) | to     | y[0]       | 6.720  | 14.309  | ns   |
+-------------------+------------+--------+------------+--------+---------+------+
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SmartTime
Bottleneck Report

Bottleneck Analysis
A bottleneck is a point in the design that contributes to multiple failing paths
SmartTime finds and lists all bottlenecks according to severity

SmartTime “Bottleneck Analysis Report” Shows
Severity: “Path_Costs”

Lists instances causing the greatest amount of delay
Reports total max delay caused by the instance

# of Occurrences: “Path_Count”
Lists instances causing greatest number of path violations

Reports number of paths affected by the instance delay
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Bottleneck Analysis Report
General Options

Format
Text or CSV

Maximum or Minimum 
Delays

Default uses Max Delay
Filter by Slack Value

Violations below the 
specified value are not 
reported
Default = 0 ns
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Bottleneck Analysis Report 
Bottleneck Options

Cost Type
Path Count
Combined Delay

Specify
Number of Paths to 
Analyze
Number of Parallel Paths 
per Section
Number of Instances
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Bottleneck Analysis Report
Set Options

Define Sets to be Analyzed:
Entire Design
Specific Clock Domain
User Defined Set

Report Instances on 
Violating Paths

From starting from location
To a destination location
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Bottleneck Analysis
Path Count Report

Path Count Report Shows:
Number of paths where  an instance is causing delay
The corresponding instance name
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Bottleneck Analysis 
Path Cost Report

Lists total combined Max Delay caused by an instance 
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SmartTime
Constraint Coverage Report

Constraint Coverage Report
Reports statistics of constraints

Met
Not Met
Not Tested
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Constraint Coverage Report
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SmartTime
Combinatorial Loops Report

Combinatorial Loop Report
Displays all loops found during initialization
Reports pins associated with the loop(s),  location where the 
loop is broken for timing analysis
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Combinatorial Loop Report
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Post-Layout Simulation

Post-Synthesis Simulation

Design Capture

Synthesis

Programming

Simulation

Place & Route

Post-P&R Simulation
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Exporting SDF File

Extract Timing delays
for post-layout simulation
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Post-Layout Simulation

Steps
Route design
Export .sdf file (Back-annotate)
Run Post-layout Simulation

SDF File Contains Delays for Min, Typ and Max

(DELAYFILE
(SDFVERSION "2.1")
(DESIGN "counter")
(VOLTAGE 2.70:2.50:2.30)
(PROCESS "WORST")
(TEMPERATURE 0:25:70)
(TIMESCALE 100ps)

(CELL
(CELLTYPE "OUTBUF")
(INSTANCE COUNT_pad_12)
(DELAY
(ABSOLUTE

(PORT D (1.65:2.55:3.52) (2.21:3.40:4.62))
(IOPATH D PAD (19.19:28.90:39.88) (17.49:26.35:38.85))

)
)
) rising 

min:typ:max
falling 

min:typ:max
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Post-Layout Simulation

Click “Simulation” in Project Flow Window or…

Right
Mouse
Click!

Click
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Post-Layout Simulation

Structural Netlist and .sdf File 
Used for Simulation

Simulator runs for 1 uS as 
Default
Max Operating Conditions 
Default
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Post-Layout Simulation
Selecting Operating Conditions

Post-layout Operating Conditions 
Can Be Specified within Libero

Tools > Options from Libero
Main Window
Select Simulation Tab in Options 
Window
Choose Min/Typ/Max



SmartPower
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SmartPower Overview

SmartPower Supports Axcelerator, RTAX-S, Fusion, 
IGLOO, ProASIC3, ProASICPLUS and ProASIC
SmartPower Features:

Power Estimate for Individual Components in Design
Hierarchical Reports of Dynamic Power Consumption
Linked to SmartTime

Uses Clock Constraints
Support for Simulation Files:

VCD (Value-Change Dump)
SAIF (Synopsys Switching Activity Interchange Format)
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SmartPower Overview

Signal
Activities

Operating
Conditions

User Design 
After Layout

Power Analysis
Report

SmartPowerSmartPower
Operating
Conditions
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SmartPower Operating Conditions (1)

Operating Conditions are Temperature, Voltage, Process

Impact of Temperature:
High on Static Power,
Limited on Dynamic Power

Impact of Process:
High on Static Power,
Limited on Dynamic Power

Impact of Voltage:
High on Static Power,
High on Dynamic Power

Impact of Radiation:
For RTAX-S, the TID reports show a very small rise in ICC at 
100Krad. This rise in ICC is so small that it is in the range of error for 
experimental measurement, and therefore is insignificant
For RT-A3P, the TID reports show that this is also true for TID < 
40Krad
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SmartPower Operating Conditions (2)

Reminder about Best and Worst Corners Power

Power Corner definition differs from Timing
Best Power Corner:

Low Temperature, Low Voltage
Worst Power Corner: 

High Temperature, High Voltage

For ProAsic3 COM  for example
Best Power Corner:      Temp=  0c,  VCCA=1.425 V,  VCCI = 3.0V
Typical Power Corner:  Temp=25c,  VCCA=1.5 V,      VCCI = 3.3V
Worst Power Corner:    Temp=70c,  VCCA=1.575 V,  VCCI = 3.6V
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SmartPower Signal Activities

SmartPower Switching Activity Estimation is Based on the 
Concept of Clock Domains

From Simple Model
Automatic Partitioning in Clock Domains by SmartPower
Only a few frequencies to set per Clock Domain

To Accurate Model
Manual Partitioning
Pin by Pin annotation or Import Simulation file

One Data Frequency

Another Data Frequency



Actel Corporation Confidential © 2009 495

Simulation Based Flow   (1)

Open Libero Simulation Options
Check the “Generate VCD file”
Checkbox Under “Do File”
VCD File is Created Automatically 
During Simulation

Actel recommends performing post-
layout simulation using the back-
annotated netlist when generating 
the VCD files
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Simulation Based Flow   (2)

Simulation based estimation, User may still affect results
Quality of Simulation Trace
Post-Layout simulation versus RTL level simulation 
Simulation for design coverage versus simulation to emulate true
patterns and timings relationships, etc
Impact of glitches

How do you know if your simulation is OK for power 
analysis?



SmartPower GUI
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SmartPower GUI
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SmartPower Summary Tab

Summary Tab Displays:
Static and Dynamic Power
Junction Temperature
Battery Life 

Power Consumption section displays total 
static and dynamic power

Breakdown section displays the power 
breakdown by type of component or by 
voltage rail or by clock domain
Data displayed as pie chart or in grid

Temperature section displays the thermal 
resistance θJA and the impact of the power 
consumption on the junction temperature 
for a given cooling scenario 

Battery Life Estimate for given battery 
capacity 
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SmartPower Summary Tab
Power Breakdown

Type:
Displays a Breakdown of the Design’s 
Power Usage by:

Net 
Gate
I/O
Memory
Clock
Core Static
Banks Static

Rail:
Displays a Breakdown of the Power 
Usage by Voltage rail 

Power, Voltage, and Current Drawn are 
Displayed for each rail

Clock Domain

Display Power Consumption by Type, Rail or Clock Domain
Pie chart or grid display
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SmartPower Summary Tab
Power Breakdown – Grid View
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SmartPower Summary Tab
Power Breakdown by Power Rail

Displays Power Consumption of all Power Rails
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SmartPower Summary Tab
Power Breakdown by Clock Domain

Displays Power Consumption of all Clock Domains
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SmartPower Summary Tab
Junction Temperature

SmartPower Estimates Junction 
Temperature (TJ)
Junction Temperature can be 
Calculated from Operating Conditions 
or Ambient Temperature
TJ = TA + θJA * (Pdynamic + Pstatic)
θJA (Package Thermal Resistance)

Cooling Scenarios:
Still Air (default)
300 ft / min
Case Cooling 
Custom

SmartPower Reports the Thermal 
Resistance θJA
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SmartPower Domain Tab (1)

Actel Vector-less Approach
Clock Constraints extracted form SmartTime
A distinct toggle rate can be set per clock domain & per type of net

If you don’t have simulation data, this step is crucial for the 
quality of the estimation.   Beware that Garbage-In => 
Garbage-Out
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Garbage-In => Garbage-Out…. What Do We mean?
Default Vector-less flow: Clock Constraints are taken from SmartTime

Always verify that your clocks 
have a correct value!

SmartPower Domain Tab (2)
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Garbage-In => Garbage-Out…. What Do We mean?
Default Vector-less flow: All Toggle Rates are set to 10%

SmartPower Domain Tab (3)

By default all Toggle Rates are set to 
10% except Set/Reset nets.

Is 10% appropriate for your design?

100 % Toggle Rate means 
FDATA = FCLOCK / 2
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Default vector-less flow with 10% toggle rates leads to +/- 100% error 
when compared to a simulation flow

% Error when using vectorless & default toggle 
rates

-100.00%

0.00%

100.00%

200.00%

1 5 9 13 17 21 25 29 33 37 41 45

46 designs

%
 o

f e
rr

or

SmartPower Domain Tab (4)
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Improved Vector-less flow: Design specific Toggle Rates

User sets a different toggle-rate value
per clock and per type of net

SmartPower Domain Tab (5)
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SmartPower Domains Tab
Initialize Frequencies

Tools > Initialize Frequencies and Probabilities
“Initialize Frequencies” Button

Use SmartTime
Clock Constraints

Specify default frequency
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SmartPower Analysis Tab

Provides Hierarchical Report of Dynamic Power 
Consumption

Hierarchy 
Instances 
Window

Selected 
Block

Static and Dynamic 
power for selected 
block

Breakdown
Window
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SmartPower Analysis Tab
Power Breakdown By Type

Analysis Grid Displays Power Breakdown for Selected Block by:
Net, Gate, I/O, Memory, Clock, Core Static, Banks Static
Grid or pie chart display
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SmartPower Analysis Tab
Power Breakdown By Instance

Analysis Grid Displays Power of all Sub-elements of 
Selected Block

Limit components to be 
displayed by checking or 
un-checking boxes
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SmartPower Activity Tab

Allows Entry of Switching Activity Information on 
Interconnects of Design

Use to Confirm Data Entered through VCD or SAIF File Import or 
pin-by-pin annotation

Select clock domain

Average frequency



Actel Corporation Confidential © 2009 515

SmartPower Enable Rates Tab

Specify Output Enable Rate for Each Bi-directional and Tri-
state I/O

Percentage of Time I/O is used as an Output

Specify Enable rates for 
individual I/O pins
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SmartPower
Importing a VCD or SAIF File

Switching information for the design can be entered by 
importing a VCD or SAIF file
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Simulation File Import Options

Specify glitch filtering
•Automatic or user-defined 
threshold

Specify start and end times for 
partial parsing of simulation file
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Simulation Based Flow

Verify Simulation Coverage and Frequencies

You can also check your Frequencies by 
type of element: clocks, inputs, set/reset…

If VCD import < 95%, I would suspect 
wrong VCD or behavioral VCD
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Simulation Based Flow
Cycle Accurate Power Analysis

Use Cycle Accurate Analysis to “debug” your Simulation in 
Terms of Power

Verifying that your power peaks are 
happening when they are expected

At the very minimum, you can verify that 
the average is not impacted too much by 
the initial reset.

You can debug any level of hierarchy
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Power Analysis
Power Consumption For Specific Clock Domain

Confirm SmartPower is in Toggle-rate Mode (Default 
Setting)

Confirm “Use Toggle Rates” Option is Checked in SmartPower
Preferences

Set all the Clock Frequencies Except the Clock Domain of 
Interest to Zero in the Domains tab

The Total Power Consumption for Clock Domain is Displayed in the
Summary tab

Includes the contribution of the clock buffer, clock tree, and all clock 
input of the registers of specific clock domain

To Determine the Power of the Clock Tree Only, set the 
Toggle Rate of the Data for the Clock Domain to Zero

Total Power Displayed is the Power of the Clock Tree
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Power Analysis
Dynamic I/O Power – Analysis Tab

Select the Highest Hierarchy Level in the Hierarchy tree in the left pane and 
Select “By Instance” from the Breakdown drop-down list
Un-check all categories under Instances Contributions except I/Os

The table displays a list of all I/Os in the design and the power contribution of 
each individual I/O



SmartPower Operating Conditions
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SmartPower Junction Temperature
Operating Conditions - General

Select Operating Conditions



Actel Corporation Confidential © 2009 524

SmartPower Junction Temperature
Operating Conditions – Temperature Settings

Define Temperature Settings:
Default, Custom Operating range or Mode by Mode range
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SmartPower Junction Temperature
Operating Conditions – Temperature Settings

Define Temperature Settings:
Default, Custom Operating range or Mode by Mode range

Specify ambient or junction temperature in custom settings
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SmartPower Custom Ambient Temp

Advanced: Custom Ambient Temperature Settings: 

You can ask SmartPower to compute
the Junction Temperature based on

an ambient Temperature that you specify

This computed Junction temperature is not
automatically propagated to SmartTime. 
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SmartPower Computes Junction Temp

Junction Temperature Computation: 

T-Junction = T-Ambient + P*θJA 

θJA is a function of the package
and cooling style

Still Air Thermal Resistance (C/W)

0 5 10 15 20 25 30

144 FBGA

208 PQFP

256 FBGA

484 FBGA

Still Air Thermal
Resistance (C/W)
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SmartPower Junction Temperature
Operating Conditions – Thermal Resistance Settings

Define Cooling Scenarios
Pre-defined or custom
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SmartPower Custom Voltage Settings

Define Custom Voltage Settings
Operating range, custom operating range or mode by mode



SmartPower Operating Modes
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Using SmartPower Modes and Scenarios

What is a Mode in SmartPower?
It is a way to save a set of parameters defining the power of a 
design
You can create modes to record:

Operating Conditions: Specific Temperature or Voltage Settings
Activities: Different simulations, or turning one clock Off…

We also offer predefined Modes:
Flash*Freeze
Sleep
Stand-by (Fusion Only)

Signal
Activities

Operating
Conditions

User Design 
After Layout

SmartPower
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Using SmartPower Modes and Scenarios

What is a Scenario in SmartPower?
It is a way to combine different modes to estimate the power over 
the life of a design, and not just in one mode

You can create Scenarios:
If you want to mix different simulations
If Operating Conditions are changing over the life of a Product

Temperature profile for Automotive
Voltage variations due to battery decay

If you want to mix different modes (Flash*Freeze and Active)

We also offer predefined Scenario:
95% Flash*Freeze – 5% Active
80% Flash*Freeze – 20% Active 
50% Flash*Freeze – 50% Active
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Using SmartPower Modes and Scenarios

Supports Analysis with all 
modes of use for the 
FPGA

Active
Shutdown
Flash*Freeze (IGLOO)
Sleep
Standby

Summary tab supports 
analysis of any mode
Use Combination of 
Modes to Create a Power 
“Scenario”
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SmartPower Custom Modes

Click to create custom mode
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Creating a Power Scenario

Specify mode and 
duration
Total must = 100%



SmartPower Reports
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SmartPower Power Reports

SmartPower can Generate the Following Reports:
Power Report
Scenario Power Report
Cycle Accurate Power Report
Activity and Hazards Power Report

Text or CSV (Comma Separated Value) Format
Customize Power Report

Items to Include in Report
Breakdown by Instance
Limit Number of Included Instances 
Specify Minimum Power Level for Inclusion in Report

Options Button Invokes Preferences Window
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SmartPower Power Report Options

Select items to 
include in report

Select report format 
and operational mode

Select operating 
conditions
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Power Report
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Power Report
Breakdown by Instance
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Scenario Power Report

Create a Power Report Based on a Power Profile 
Report shows where/how much power is consumed

Power Report
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Cycle Accurate Power Report
Overview

Feature Definition
Offers Peak Power Analysis from a Simulation (VCD) file
Allows Cycle by Cycle analysis of the Power over the simulation

Why Cycle Accurate Power Report?
For critical applications, a cycle accurate report allows designing for  
worst-case scenario

A cycle accurate report allows simulation and analysis of power 
saving scenarios (example: clock with variable frequency)
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Cycle-Accurate Power Reporting

Accurate report of peak 
power per clock cycle 

Based on testbench
Cycle-by-cycle analysis of 
the power over the 
simulation
Allows designing for  worst-
case scenario 

Cycle-by-cycle power 
profile

Worst cycle reported

Select Options
-Specify sampling 
period
-Report format and 
results
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Cycle Accurate Power Report

Cycle Accurate Power Report (mW)

0

5

10

15

20

25

1 78 155 232 309 386 463 540 617 694 771 848 925 1002

Average Power during
Multiplication Operation

Max Power is more than
2 * Average Power



Actel Corporation Confidential © 2009 545

Activity and Hazards Power Report
Overview
Feature Definition

Allows the analysis of power dissipated by Hazards from a Simulation 
(VCD) file.

Definition of Hazard: Due to the delay mismatch along different fan-
in paths of each internal gate, the output of a gate may have 
unexpected transitions before settling to the correct logic level. 
These transitions are called hazards or spurious transitions 
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Hazard Analysis

Hazards can account for as much as 20% of total global 
power*
Power dissipation caused by hazards can be much as 70% 
of total power

Report Highlights 
# of functional transitions, # of hazards and their associated power

*According to Favalli and Benini, International Symposium on Low Power Electronics and Design, 1995
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Activity and Hazards Power Report
Options

Query Options:
Report: Activity, Activity and Power, Power
Sort by: Functional power, functional transitions, 
spurious power, spurious transitions, total power
Sort order: ascending, descending
Number of reported nets: enter a value
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Activity and Hazards Power Report
Example 1

For each net, report activity; sort by spurious transitions;
sort order descending; Limit the number of reported nets to 50.

We analyze the simulation cycle by cycle, and net 
per net, and we report the number of functional 
transitions and spurious transitions for each net
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Activity and Hazards Power Report
Example 2

For each net, report activity and power; sort by power; sort 
order descending; Limit the number of reported nets to 40.

We are also able to report functional power
and spurious power for each each net 
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Programming & Debugging

Post-Synthesis Simulation

Design Capture

SynthesisSimulation

Place & Route

ProgrammingPost-P&R Simulation
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Generating Programming File

Generate programming  
file

Select features to be programmed
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Hands-on Labs 7, 8 and 9

Complete Labs 7, 8 and 9 in the Lab Guide
Lab 7

Layout Design
Generate Global Usage Report
Create backannotated timing file
Save your Work

Lab 8
Run Post-layout timing simulation
Create VCD file 

Lab 9
Measure Power Consumption with SmartPower
Generate the programming file



Programming
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Sculptor 3 Overview

PC-based Parallel-port, Single Device Programmer
Replaces Silicon Sculptor II
Compatible with all Sculptor II Adapter Modules
Supports all Devices and Families:

IGLOO/e, Fusion, ProASIC3/E, ProASICPLUS

ARM-enabled Flash FPGAs
All anti-fuse products including RTAX4000S
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Available from Actel Website
http://www.actel.com/custsup/updates/silisculpt/

Requirements (Windows Version)
Microsoft Windows 95/98, Win NT or Win 2000

Requirements (DOS Version)
286 with 4MB RAM, Approx. 6MB Hard Drive Space
DOS-driven Program - Memory Managers Not Required
DOS Shell from Windows 95/98 - OK
Does Not Work with Windows NT

Silicon Sculptor Software
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Flash Programming

Flash FPGA Devices Can Be Programmed Multiple Ways
Off-board Programming with Silicon Sculptor 3
In-System Programming (ISP) using JTAG Interface with:

Silicon Sculptor 3 (ProASIC, ProASICPLUS, ProASIC3/E, Fusion, 
IGLOO/e)
Flash Pro (ProASIC or ProASICPLUS)
Flash Pro Lite (ProASICPLUS)
Flash Pro 3 (ProASIC3/E, Fusion, IGLOO/e)

Programming via Microprocessor Interface
(ProASICPLUS, ProASIC3/E, Fusion, IGLOO/e)
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FlashPro Programmer
ProASIC, ProASICPLUS

Small Form Factor - 24 in3

Low Cost 
Hardware Features

Small 26-pin Header
Samtec FTSH-113-01-L-D-K

20” Ribbon Cable
ECP Parallel Port

Software Features
Win 95/98/NT/00 O/S
STAPL Support
Daisy Chain Capability
Log File Generation
Self-test Option
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FlashPro Lite Programmer
ProASICPLUS

Low Cost 
Ultra-small Form Factor
Hardware Features

Draws Power from Target Board
Connects to Parallel Port 
Supports In-system Programming

Samtec 26-pin Header

Software Features
Supports Windows 98, NT, 2000, and XP Operating Systems 
STAPL Support 
Free Software Updates 
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FlashPro 3
ProASIC3, ProASIC3L, Fusion and IGLOO

USB 2.0 High-speed Interface
10-pin JTAG ISP
Altera-compatible Interface

Programs ProASIC3 Devices in Less than 2 Minutes
Powered by USB Connection

Parallel Programming Requires Powered USB Hub
Variable TCK (up to 24 MHz)

Recommend <= 20MHz for PA3/E
Optional Transition Board provides Adapter Cables for 26- and 10-pin 
SAMTEC
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Programmer Summary

Programmer Device Support Availability

Silicon Scupltor 3

All antifuse FPGAs                                             
ProASIC3/E, ProASIC3L, Fusion, IGLOO/e       
ProASIC and ProASICPLUS Available

FlashPro ProASIC and ProASICPLUS  Available
FlashPro Lite ProASICPLUS  Available
FlashPro 3 ProASIC3\E, Fusion, IGLOO/e Available



FlashPro 8.5
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FlashPro v8.5 Software Overview

Works with all FlashPro series programmers
FlashPro3, FlashPro Lite and FlashPro

Supports A500K, APA, ProASIC3/E/L, AFS and AGL with 
appropriate programmer

ProASIC3/E/L, AFS and AGL support via FlashPro3 only
Allows programming in parallel via USB hubs

Huge increase in throughput for small-scale production
FlashPro3 and FlashPro can be operated in parallel

Supports Chain Programming
Supports Device Serialization
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FlashPro User Interface

Menu Bar

Tool Bar

Log 
Window

Flow 
Window

Status Bar
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Programming with FlashPro

Launch FlashPro
Load STAPL File
Select Action
Execute Action
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Invoking Programming Software from Libero

Click “Programming” in Project Flow Window or…

Click

Right
Mouse
Click!
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FlashPro GUI

Select Configure Device File to Display Programming File
Single File Configuration Window is Displayed
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FlashPro
Select Action and Execute Action

Select Action to Perform from Pull-down Menu

Select Action 
from pull-down 
menu

Programming 
file details
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FlashPro
Programmer Status

Programmer Status is Displayed in Programming List 
Window

Programmer 
Status

Programmer 
List Window
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FlashPro
Programming Complete

Successful Programming is Indicated in the Programmer Status Column
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FlashPro
Connecting Multiple Programmers

FlashPro 8.5 Supports Connecting Multiple Programmers 
To One Computer

Select or de-select 
programmers

Scan for 
programmers



Parallel Programming
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Parallel Programming

Operation/Production Programming
Programming multiple Flash devices using single GUI

FlashPoint

FlashPro v6.2+STAPL File FlashPro3
JTAG

ProASIC3/3E
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Parallel Programming (cont)

A3P

PC HUB FP3

FP3

FP3

A3P

A3P

A3P

FP3

HUB

PC HUB FP3

FP3

HUB

A3P A3P A3P

FP3

FP3

A3PA3PA3P

A3PA3P

A3P A3P

A3P

A3P



Chain Programming
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Overview

Why Chain Programming?
We want to program Actel devices with non-Actel devices in 
the same JTAG chain
Devices are programmed in sequential order

3 2 1 TDOTDI

Control lines

A3P250 Non-Actel AFS600

Programmer

First device  - TDO 
connects to the programmer

Last device  - TDI 
connects to the 
programmer
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Chain Programming

Steps:
Create a FlashPro project 

Specify Chain Programming

Configure the Chain
Select Programming file for device(s) 
to be programmed
Select BSDL file for device(s) to be bypassed

Can manually enter IR length and maximum TCK rate
Program Chain
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Chain Programming
Automatic Chain Configuration

Configuration > Construct Chain Automatically
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Chain Programming
Manual Chain Configuration

Manually Add Devices from Configuration Menu
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Manual Configuration
Adding a Device

Actel Device
Select Programming file
User can specify custom 
name

Non-Actel Device
User can select BSDL file

Provides the Max TCK 
Frequency and IR 
length for device

User can enter data 
directly if they do not have 
access to a BSDL file
User can enter custom 
name for device
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Configured Chain

Devices in chain

Log Window displays 
messages about chain 
configuration and 
programming
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Programming the Chain

Select device(s) to program
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Programmed Chain

Messages indicate 
status of each 
device to be 
programmed



Device Serialization
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Device Serialization: 
STAPL File Format

When Using FROM with Serialization Feature
User can select the target programmer

STAPL Serialization
For Silicon Sculptor II or 
Sculptor 3, BP Auto 
Programmer or FlashPro3
Actel and BP specific 
STAPL format to support 
device serialization
Auto Serial Index 
Increment

Generic STAPL Player
Each FROM and ARRAY 
content has its own 
action
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Device Serialization:
STAPL File Format

STAPL File
…………………..

DATA FROM_BITSTREAM_BLOCK;

BOOLEAN FRomStream_1[128]=

$0000000000000000000000000000000A;

BOOLEAN FRomStream_2[128]=

$0000000000000000000000000000000B;

BOOLEAN FRomStream_3[128]=

$0000000000000000000000000000000C;

…………………………………………..

Device 1

Device 2

Device 3
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Serialization Options

What Should Happen when Programming fails on a 
Single Board with one Device?

User has GUI option in FlashPro to 
Reprogram same serial number (Reuse)
Program with the next sequential number 
(Skip)

PC HUB A3P

Board1

FP3 A3P

A3P

Board2

A3P

Board3

A3P

Board4



Debug Tools
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FPGA Debug Tools

Identify AE
Silicon Explorer II
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What is Identify AE?

RTL Source Level Hardware Debugger from Synplicity
Allow internal visibility in the target system at full speed
Trigger on data path and control path
Instrument and Debug Design directly in RTL source code 
View data in standard waveform display
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Identify AE Product Specification

Supported Devices
Identify AE v3.0.2A: ProASICPLUS, ProAsic3, Fusion and IGLOO

Supported Programmers:
FlashPro, FlashPro Lite and FlashPro3

HDL Language Support 
VHDL, Verilog or mixed language designs

FREE 1 year License
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FPGA Debug Tools

Identify AE
Silicon Explorer II
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Silicon Explorer

Debug Antifuse Designs in Real Time!
Select Internal FPGA Nodes on the Fly for Viewing while Device 
Runs at FULL Speed!
Reduce Debug Time and Decreases Time to Market!

Design

Prototype

Select 
Nodes

Observe
Results

Debug
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Action Probe Circuitry

Dynamic Internal Node Access
No Changes to Timing 
Relationships
No Changes to Fan-out or Node 
Loading

Patented Architectural Feature
Antifuse Devices Only
Unique to Actel

No Silicon Overhead
Uses Zero Logic Resources
Always there if Needed

Control

Registers
R

egisters
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Summary

Libero FPGA Design Suite Includes:
Design Entry

ViewDraw, HDL Editor, SmartGen, SmartDesign
Synthesis

Synplicity
Verification

ModelSim, WaveFormer Lite
Designer (P&R, Timing Analysis and Constraints)

Actel Continues to Improve Libero IDE
Increased Quality of Results
Ease of Use
Additional Features



Reference Material



Actel Corporation Confidential © 2009 596

Reference Material

SmartGen
ViewDraw
CoreConsole
WaveFormer Lite
ModelSim Dataflow and List Windows
Synplify Attributes and Directives
Chip Editor
SDC Timing Constraints
Silicon Sculptor
Device Serialization



SmartGen



Actel Corporation Confidential © 2009 598

SmartGen RAM Initialization

Speeds Simulation Time by 
Reducing the Initial Writes to 
Setup the Memory
Completely Automated 
Simulation Flow
MEMORYFILE Property 
Preserved Throughout the 
Design Flow
Cascading of Multiple RAM 
Blocks Handled Automatically
Supports Industry Standard 
Memory Content Specification 
Files

SmartGen

Memory Content 
Manager .mem

RAM 
netlist

Simulation

Synthesis Post-Synthesis 

Designer Backannotation

BA_RAM 
netlist

.hex/.s 
memory 

file

Pre-Synthesis 
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SmartGen RAM Initialization
ProASIC3 and Axcelerator (cont.)
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Memory Content Manager - Features

Variable Aspect Ratio 
Support

Read View & Write View 
Import of User Memory 
File

Intel hex format
Motorola- S format

Multiple Radix for Data 
and Address Display

Hexadecimal
Binary
Decimal
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SmartGen Soft FIFO Controller

Create Controller With or Without Memory 



ViewDraw
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Built-in Library Contains Several Sheet Border Templates
Templates Can Be Modified

Adding Schematic Border

Select built-in library

Enter sheet name (asheet, bsheet, etc.)

Drag and drop
into schematic
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ViewDraw Border in Schematic
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Customizing a Schematic Border

Border Template Can Be Customized
Open Border (File > Open)

Select Symbol from “Type” Menu

Select built-in library

Select Symbol
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Select project library

Select Symbol

Enter new sheet name

Customizing a Schematic Border (cont.)

Save File to New Name
(File > Save Copy As <name>)
Border Saved in Project Library

Visible on Libero File Manager Tab
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Customizing a Schematic Border (cont.)

Open Saved Border and Edit (File > Open)
Add Lines, Arcs, Text, etc. as Necessary

Modified border visible 
on File Manager tab



CoreConsole
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CoreConsole IP Deployment Platform

System-level Design Builder 
Fast assembly and configuration of user designs
Easy to use graphical user interface

Incorporated IP Delivery
Users can access IP modules in the IP Vault

Some modules require a separate license
System Output 

Configured RTL can be either plain text or 
obfuscated
CoreMP7 and other protected IP output as a 
blackbox
Output includes

System and IP test benches
Memory map generation with software driver export
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CoreConsole/Libero IDE Design Flow
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Click CoreConsole Button in Project Flow Window
Add and Stitch Components
Generate IP

Opening CoreConsole

Enter name
Select CoreConsole
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CoreConsole v1.4
User Interface

Version Selection

Component Filter

Add Components

Component Summary

Schematic Window
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CoreConsole v1.4
GUI Tabs

Add Components
List of Available IP, Click to 
Add to Design

Design
Configure and Stitch Each
Component in Design
(Done Directly in Schematic 
Window)

Generate
Generate Design RTL
and Other Items
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CoreConsole v1.4

Automatic Detection or Manual Check For New/Updated 
Cores
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CoreConsole v1.4
Add Components

Components Tab Lists Available 
Components
Push Button to Add Component
Multiple Instances of the Same Core 
Are Given Unique Names in 
Schematic

List of available cores

Push button to ADD
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Generate

Select VHDL or Verilog
Check License Info if 
Required
Click Save & Generate

It May Take a Few Minutes!
Output Project Appears on 
Libero Files tab
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CoreConsole Project in Libero

CoreConsole Project



WaveFormer Lite
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Copying to a Different Signal

Signal Can Be Copied
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Copying to a Different Signal

Signal Can Be Copied
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Copying to a Different Signal

Signal Can Be Copied
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Copying to a Different Signal

Signal Can Be Copied
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Copying to a Different Signal

Signal Can Be Copied
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Copying to a Different Signal

Signal Can Be Copied



Actel Corporation Confidential © 2009 625

Copy of waveform
is inserted!

Copying to a Different Signal

Signal Can Be Copied
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Reactive Test Bench:
Stimulus and Expected Response

Draw stimulus waveforms on the input ports of the model 
under test.
Draw expected response waveforms on the output ports of 
the model under test
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Reactive Test Bench:
Samples

Samples Verify MUT Output 
Sample constructs can monitor and perform actions based on the 
data sampled
Sample can work at a single point or over a windowed area  
Sample can perform relative to the beginning of the transaction or 
relative to another event in the diagram.
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Reactive Test Bench:
Control & Looping

Markers used for Control & Looping Sections of 
Transactions

Specify the end of the transaction
Create loops using for, while, and repeat loop markers
Insert HDL code
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Reactive Test Bench:
Variables

Variables Parameterize State Values 
Variables can drive values on stimulus waveforms
Variables can store values on expected waveforms 
Waveform states can be expressed as conditional expressions using 
variables 
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Reactive Test Bench:
Delays

Delays Parameterize Time Values 
Delays represent the time between two edges in the diagram

Specify min and max values
Delay values can be time or cycle-based
Conditionally control when edges occur
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Reactive Test Bench:
Help Resources

Online Manual: 
Choose Reactive Test Bench Generation Under the Help menu

PDF Manual:
Reactive_testbench_Generation_Option.pdf under the Help folder 
in the SynaptiCAD install directory

SynaptiCAD’s website: www.syncad.com



ModelSim AE
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Dataflow  Window

Explore physical connectivity of design
Displays processes, signals,  
nets and registers
Links to Main, Process, 
Signals, Wave and Source 
windows

Find feature allows searching 
for signal, net or register 
names
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Dataflow Window
ModelSim AE Simulator

The ModelSim AE simulator has a limited Dataflow 
functionality

Only one process and it’s attached signals or one signal and it’s 
attached processes are displayed

Zoom
control

Display net drivers 
or readers
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List Window

Simulation Results in Tabular 
Format

VHDL - Signals and Process 
Variables
Verilog - Nets and Registers

“Drag & Drop”
Find Function
Trigger / Strobe Properties
Write List

Tabular
Event
TSSI

Markers - Add, Delete or Goto
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Saving Tabular Output

Drag & Drop!



Synplify Attributes and Directives
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syn_keep
Directive

Maintains Net Throughout Synthesis
During Synthesis, Nets May Not Be Maintained in order to Create 
Optimized Circuit

Applied to wires in Verilog and signals in VHDL
Nets Can Be Preserved to

Probe their Values during Simulation
Prevent Certain Optimizations, such as Clock Enable Optimization

Example:

signal q_tmp : std_logic;
attribute syn_keep : boolean;
attribute syn_keep of q_tmp : signal is true;
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alspreserve
Actel-Specific Attribute

Keeps Net from Being Collapsed in Designer (Back-end) 
Tools

Must also Add syn_keep to Ensure Synplicity Retains Net
Synplicity Adds alspreserve Attribute to EDIF Netlist
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alspreserve
Syntax

Verilog Syntax
object /* synthesis alspreserve = 1 */ ;

Example:

VHDL Syntax
attribute alspreserve of object : signal is true ;

Example:

module foo ( in, out);
input [6:0] in;     output out;     wire out;
wire or_out1    /* synthesis syn_keep=1 alspreserve=1 */;
wire and_out1;     wire and_out2;
wire and_out3  /* synthesis syn_keep=1 alspreserve=1 */;

architecture comb of foo is
signal and_out1, and_out2, and_out3, or_out1 : std_logic;

attribute syn_keep of and_out3 : signal is true;
attribute syn_keep of or_out1  : signal is true;
attribute alspreserve: boolean;
attribute alspreserve of and_out3 :signal is true;
attribute alspreserve of or_out1 : signal is true;
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syn_encoding
Attribute

Sets Encoding Style for State Machines
Overrides Default Style

Default Style - Compiler Selects Encoding Style Based on 
Number of States as Follows:

1 - 4 States: Sequential
5 - 24 States: One-hot 
> 24 States: Gray 

syn_encoding Can Have the Following Values:
onehot
gray
sequential
safe



Actel Corporation Confidential © 2009 642

syn_encoding
Attribute Usage

SCOPE Constraint Editor Usage
Select Individual State Machines and Assign Attribute
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syn_encoding
Attribute Usage (cont.)

Verilog Syntax
object /* synthesis syn_encoding = "value" */ ;

Example:

VHDL Syntax
attribute syn_encoding of object : object_type is "string" ;

Example:

module prep3 (CLK, RST, IN, OUT);
input CLK, RST;
input [7:0] IN;
output [7:0] OUT;
reg [7:0] OUT;
reg [7:0] current_state /* synthesis syn_encoding="gray" */;
// Other code

library synplify;
use synplify.attributes.all;
package my_states is
type state is (st0, st1, st2, st3, st4, st5);
signal s1 : state;
attribute syn_encoding of s1 : signal is "gray";
end my_states;
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syn_maxfan
Attribute

Controls Maximum Fanout of Instance, Net, or Port
Limit Specified by this Attribute May Be Treated as Hard or 
Soft Depending on Where It Was Specified

Soft Limit May Not Be Honored if it Degrades Performance
You Can Apply syn_maxfan Attribute to Module, Register, 
Instance, Port, or Net 

For ProASIC and APA Designs Only – You Can also Apply to Module or 
Entity  
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syn_maxfan
Usage

SCOPE Constraint Editor Usage

SDC File Syntax
define_attribute { object } syn_maxfan { integer }

Example – Limit Fanout for Signal clk to 200:

. . .
define_attribute {clk} syn_maxfan {200}

. . .
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syn_maxfan
Syntax

Verilog Syntax
object /* synthesis syn_maxfan = "value" */ ;

Example:

VHDL Syntax
attribute syn_maxfan of object: object_type is "value“;

Example:

module test (registered_data_out, clock, reset, data_in);

output [31:0] registered_data_out;  input clock, reset;

input [31:0] data_in;

input reset /* synthesis syn_maxfan=1000 */;

// Other code

entity test is
port(clock, reset : in bit;

data_in : in bit_vector(31 downto 0);
registered_data_out: out bit_vector(31 downto 0))

attribute syn_maxfan : integer;
attribute syn_maxfan of reset : signal is 1000;
-- Other code
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syn_replicate
Attribute

Prevents Replication of Register
assign syn_replicate = 0 Turns Off Register Replication
Cannot Force Tool to Replicate
Works along with max_fanout Value
Only Supported on Individual Register

When Will Synplify Replicate or Buffer?
Generally Flip-flops Are Replicated to Achieve Fan-out Control
Combinatorial Cells May be Replicated to Control Fanout
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syn_replicate
Usage

SCOPE Constraint Editor Usage

SDC File Syntax
define_global_attribute syn_replicate = { 1 | 0 }

Example - Disables All Replication in Design: 1 enables replication
0 disables replication

. . .
define_global_attribute syn_replicate {0}

. . .
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syn_replicate
Usage (cont.)

Verilog Syntax
object /* synthesis syn_replicate = 1 | 0 */;

Example:

module norep (Reset, Clk, Drive, OK, ADPad, IPad, ADOut);

. . .
reg [31:0] IPad;

reg DriveA /* synthesis syn_replicate = 0 */;

assign ADPad = DriveA ? ADOut : 32'bz;

always @(posedge Clk or negedge Reset)

if (!Reset) begin

DriveA <= 0;

IPad <= 0; end

else        begin

DriveA <= Drive & OK;

IPad <= ADPad;  end

endmodule

0 disables replication
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syn_replicate
Usage (cont.)

VHDL Syntax
attribute syn_replicate of object : object_type is true | false ;

Example:

entity norep is port (
Reset : in std_logic;
Clk : in std_logic;
Drive : in std_logic;
OK : in std_logic;
ADPad : inout std_logic_vector (31 downto 0);
IPad : out std_logic_vector (31 downto 0);
ADOut : in std_logic_vector (31 downto 0));

end norep;
architecture archnorep of norep is
signal DriveA : std_logic;
attribute syn_replicate : boolean;
attribute syn_replicate of DriveA : signal is false;

begin

-- Other code

false disables replication
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syn_sharing
Directive

Enables/Disables Resource Sharing of Operators inside 
Module during Synthesis 

By Default, Directive Is Enabled (Value 1 for Verilog, true for VHDL). 
If Resource Sharing Check Box in Project View is Disabled, You Can 
Still Enable Resource Sharing Using syn_sharing Directive 
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syn_sharing
Usage

Verilog Syntax
object /* synthesis syn_sharing = 1 | 0 */ ;
Example:

VHDL Syntax
attribute syn_sharing of object : object_type is " true | false"; 

object can be architecture name
Example:

module my_design(out,in,clk_in) /* synthesis syn_sharing=0 */;

// Other code

entity alu is 
port ( a, b : in std_logic_vector (7 downto 0);

. . . );
end alu;
architecture behave of alu is
-- Turn on resource sharing for the architecture.
attribute syn_sharing of behave : architecture is "true";
begin
-- Other code
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syn_noclockbuf
Synthesis Attribute

Selects/Deselects Automatic Clock Buffering
Value of ‘1’ (or Boolean TRUE) Turns OFF Automatic Clock 
Buffering
You Can Apply syn_noclockbuf Attribute to Module, Register, 
Instance, Port, or Net

Synplicity SCOPE Constraint Editor Usage
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syn_noclockbuf
Attribute Usage (cont.)

Verilog Syntax
object /* synthesis syn_noclockbuf = "value" */ ;

Example:

VHDL Syntax
attribute syn_noclockbuf of object : object_type is "value" ;

Example:

module test (registered_data_out, clock, reset, data_in);

output [31:0] registered_data_out;  input clock;

input [31:0] data_in;

input reset /* synthesis syn_noclockbuf=1 */;

// Other code

entity test is
port(clock, reset : in bit;

data_in : in bit_vector(31 downto 0);
registered_data_out: out bit_vector(31 downto 0))

attribute syn_noclockbuf : boolean;
attribute syn_noclockbuf of reset : signal is true;
-- Other code
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syn_global_buffers
Synthesis Attribute (ProASIC3/E, Fusion, IGLOO/e)

Specifies The Number Of Global Buffers To Be Used
Use This Attribute To Restrict The Number Of Global Buffer 
Resources Used by Synplicity
Attribute Is Applied Globally On The Top-level Module Or Entity 
Value Can Be Any Integer Between 6 And 18

Synplicity SCOPE Constraint Editor Usage
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syn_global_buffers
Attribute Usage

Verilog Syntax
object /* synthesis syn_global_buffers = <maximum> */;

Example:

VHDL Syntax
attribute syn_global_buffers of object : object_type is 
<maximum>;

Example:

module top (clk1, clk2, clk3, clk4, clk5, clk6, 
clk7,clk8,clk9,  clk10, clk11, clk12, clk13, clk14, clk15, 
d1, d2, d3, d4, d5, q1, q2, reset) 

/* synthesis syn_global_buffers = 10 */;

entity top is 

port(      . . .       );

end top; 

architecture behave of top is

attribute syn_global_buffers : integer;

attribute syn_global_buffers of behave : architecture is 10;
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syn_ramstyle
Synthesis Attribute

Manually Indicates How Inferred RAM is Implemented
Values

block_ram (default) – Inferred RAM Will Use Block RAM if Possible
RAM Larger than One Block Will Be Cascaded
By Default, Software Uses Deep Block RAM Configurations instead of Wide 
Configurations for Better Timing Results

Example: 4Kx8 Built from 512x8s instead of 4Kx1s
Deeper RAMS Reduces Output Data Delay Timing by Reducing the MUX Logic at 
RAM Outputs of the RAMS

registers – Inferred RAM Will Be Implemented as Registers
no_rw_check – Implements RAM without Glue Logic

Glue Logic to Bypass RAM Is Added by Default because Simultaneous Read and 
Write at the Same Address Gives Indeterminate Data

Possible Simulation Mismatch

syn_ramstyle Attribute Is Applied to Memory Array
Value of select_ram (Indicated in Documentation) Does Not Apply to 
Actel RAMs


